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Introduction
This Guidebook contains detailed instructions on how to collect baseline information about your organization’s current structure and administrative services activities.  These data collection activities are the first step toward identifying how your organization and workforce infrastructures will need to change to implement Simplified Administrative Services and MARS (Management and Administrative Reporting System).

The information collected now will help your agency:

· identify the scope and timing of training for MARS,

· ensure appropriate coverage for future activities,

· identify opportunities for efficiencies, and

· identify anticipated workstation and MARS usage requirements.

This information is critical because it will help support our objectives, which include:

· Employees receive necessary training.

· Stakeholders are well informed about MARS implementation.

· Employees understand their new roles and responsibilities.

· Employees are prepared to implement MARS and any new processes.

The data collection process involves eight primary steps.  To facilitate this process and ensure that all agencies use a consistent, systematic and objective approach to MARS implementation, you have been given a series of Microsoft Word and Microsoft Excel tools.  This Guidebook provides step-by-step instructions to completing these tools and other data collection activities.

Helpful Definitions

Before beginning the data collection process, it may be helpful for you to review some definitions.  The following terms are specific to the EMPOWER Kentucky initiative and the Simplified Administrative Services project.

Administrative Services

Administrative services are those activities that support financial and materials management functions for state government.  Those functions include:

· Procurement Planning
· Budgeting

· Vendor Management
· Intra-governmental Transactions

· Ordering
· Accounts Payable/Disbursements

· Bidding
· General Accounting

· Receiving
· Cash Receipts/Cash Flow

· Inventory Management
· Accounts Receivables

· Disposal
· Management Reporting 

· Post-Audit
· Management Decision Support

A central theme of the Administrative Services Project process redesigns involves a shift in accountabilities and responsibilities between the Finance and Administration Cabinet and the other state government program Cabinets and Agencies.  The basic nature of the shift is a transfer of accountability and authority for process execution and control to those program Cabinets and Agencies.  Over time, the Finance and Administration Cabinet will transform its role to one which focuses on maintaining an effective and efficient process infrastructure (policies and systems) and providing value-added services (advice, expertise) to managers and employees throughout the Commonwealth.  Accordingly, program Cabinets and Agencies will need to establish the capabilities to accept both the responsibility for control and execution of transactions as well as the accountability for related decisions.

Agency

For the purposes of this training, your agency is your cabinet or constitutional office.

Business Improvement Projects (BIPs)

The Business Improvement Project (BIP) addresses a wide range of centralized and agency material management practices.  The BIP team is made up of members from a variety of agencies in state government.  Several team members were charter members of the original Material Management Team who created the “brown paper maps” of the “as is” world as a visual tool for determining the need for change.

The Business Improvement Project focuses on 1) procurement planning to leverage the state’s purchasing power 2) alternatives to the state’s costly warehouse infrastructure 3) Procurement Card 4) MARS preparatory activity through encouragement of Treasury mailed checks, streamlined electronic approval routing paths, and KAPs rollout.

EMPOWER Kentucky

EMPOWER Kentucky is a statewide initiative to change the way the Commonwealth does business in order to save costs, increase revenues and improve services to its citizens.  Changes to existing processes were developed by cross-Cabinet groups of over 250 state employees and approved by a redesign committee consisting of senior leaders in the Executive and Legislative Branches of state government.
EMPOWER Kentucky Business Case

The Business Case started as a tool the Executive Leadership of the Commonwealth used to prioritize EMPOWER Kentucky funding requests.  Proposed project costs and benefits (both tangible and intangible) were compared in a standard approach.  The results were then ranked and presented to the EMPOWER Kentucky Redesign Steering Committee for concurrence.  Subsequently, the business cases are being used as a management tool for EMPOWER leadership and process owners.  Achieving the business case, particularly as it relates to financial impact is key to the success of EMPOWER.  Benefits generated from EMPOWER projects are being used by the Governor to fund strategic initiatives.  

As the business case is disaggregated to the Cabinet budget level, each Cabinet will be responsible for achieving the cost reductions, revenue enhancements or service improvements identified.  The cost savings from the Administrative Services initiatives for this biennium have been extracted from each Cabinet’s budget.  The Business Improvement Team is working with Cabinet staff to achieve these savings as well as monitoring performance through the Agency Scorecard.  We expect a similar model to occur with MARS.
Management Administrative and Reporting System (MARS)

The Management Administrative and Reporting System is an enterprise-wide system that will support state government’s administrative processes.  When it is implemented in July of 1999, MARS will support both the state’s financial and materials management processes and replace a number of legacy systems including STARS and KAPS.  

MARS will be based on packaged software from American Management Systems, Inc. (AMS) and will bring the benefits of new client/server and relational database technology to the Commonwealth.  Among the benefits will be: an automated budget preparation process; automated workflow; automated match and payables processing; web based travel vouchers and purchase requisitions; and significantly improved data access and reporting capabilities.

Organizational Design

Organizational design activities support agency implementation of Administrative Services redesigns and assist agencies as they meet provisions set forth in the EMPOWER Kentucky business case.  Organizational design is defined as:

· Restructuring of an agency’s administrative units at the cabinet, department, division, and branch level

· Assessing the cost and benefits of restructuring

· Assessing fiscal impact across these units to reflect changes in FTEs and other resource requirements

· Changing reporting relationships

· Integration and communication with the overall Commonwealth Administrative Services Infrastructure

Statewide Purchasing Contract Agreements

These contracts are being developed to respond to multi-agency purchasing needs.  Several commodities are frequently and routinely purchased, so they are best suited for a statewide contract approach.  In some cases, these large scope contracts can be awarded by region to best structure a vendor delivery network for our agencies.  In each case, a cross-cabinet purchasing team is assembled to ensure the contract bid is responsive to each agency’s needs.  This team researches the commodities and services, vendor capability, proposed usage, delivery, product quality, safety issues, develops the evaluation criteria and evaluates the vendor bids and many other areas for consideration.

Several commodities are a best fit for delivery through this type of contract arrangement:

· Office Supplies

· Medical Supplies

· Building Materials & Supplies

· Janitorial Supplies

· Uniforms

These contracts are designed to reduce administrative burden, assist with locating a “best value” source, offer faster delivery for core items, provide brand selection, and facilitate use of the state procurement card – in addition to other purchasing enhancements.

Warehouse Optimization

The Warehouse Optimization effort resulted from problems with our existing warehouse infrastructure.  Dependence on warehousing has made it easy for us to neglect a strong procurement planning approach for too long.  Large stockpiles in warehouses often represent a cash investment that is no longer necessary to meet agencies’ business needs.   For some time now, vendors have been providing just-in-time delivery and prompt payment discounts to private sector businesses, in the process avoiding costly investments in warehousing.  The state’s practice of stockpile purchasing was our best indicator that our procurement process was broken.  

To date, the Business Improvement Project Team has identified 106 facilities used by our agencies for redistribution centers, forms distributions, storage of surplus equipment and in some cases junk.  We justified spending funds on these facilities because we couldn’t get what we needed when we needed it and because, at first glance, volume discounts appeared to be a good purchasing decision.  While bulk buying may secure some immediate volume discounts, the state also has a large investment in the storage and redistribution of this inventory/stock, which in some cases, will not cost more to ship to the appropriate location.  

State employees addressed the situation by proposing a common sense business strategy -- apply the same purchasing practices we use at home to a state agency’s business needs.  Each day we all make decisions about what we will buy for home, when best to make those purchases, quantities to purchase, considering seasonal, budgetary, and any other factors that must be weighed.  The warehouse optimization analysis prepares us for making those same decisions to meet an agency’s purchasing needs.   This analysis provides a review of all processes, from beginning to end, to determine how to improve customer services.  Agency warehouse and procurement staffs gather the data necessary to support the analysis.  Recommendations are then developed for the improvement of the day-to-day activities using procurement planning, just-in-time delivery, procurement card, and inventory on hand for spend down.

Workforce Transition

The EMPOWER Kentucky project is committed to supporting a smooth transition for all employees whose jobs are impacted by the process redesigns.  To that end, the Personnel Cabinet, agency personnel administrators and EMPOWER teams have developed a strong organization for assistance with workforce transition issues.  Workforce Transition is defined as:

· Redeployment of state employees whose positions are affected as a result of the EMPOWER redesigns 

· Reclassification of jobs due to significant changes in employees’ roles and responsibilities

· Creation of new job descriptions to support new activities as a result of MARS or Business Improvement Projects (BIPS) 

· Scheduling and planning the transition from the old to the new job duties

· Communication, counseling, and other support activities for the above, which includes communication to those who are and are not affected by the transition.

The Data Collection Process and Tools

Data collection involves compiling information about your agency’s current structure and identifying the divisions and branches within that structure where administrative services functions are performed.  You will also need to collect data about the employees who perform these functions.  
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Agency

Department

Division

Branch

Auth-

orized

Filled

Unfilled

Financial 

Mgmt

Materials 

Mgmt

Support 

or 

Cyclical

Personnel/PFTs

AS Activities Checklist

3) 

Meet with the Personnel 

Administrator or other resource.

4)

 List the Divisions and Branches 

under the appropriate Department.

1) 

Open the 

file.

2)

 Enter the 

name of each 

Department.

5) 

Enter the number of personnel or PFT's.  Begin at 

the lowest level - here the Branch level.  At higher 

levels of the organization, enter only the personnel that 

support that level but are not a part of other Divisions, 

Branches, etc.

6) 

Mark cells with an "x" if 

administrative services 

functions are performed within 

that organizational unit.

[image: image17.wmf]The following illustration provides an overview of the eight major steps in the data collection process.  You may not need to complete all of these steps if your agency is small or limited in administrative services functions.

Two Diskettes, “Course 1 Disk 1” and “Course 1 Disk 2” were provided to your team during training.  As shown in the table below, these diskettes contain eight data collection tools and a copy of this Guidebook.  Disk 2 also contains completed examples of the tools.  All of the tools are either Microsoft Word or Microsoft Excel files that have been saved in formats compatible with Microsoft Office 95 or later.

Disk 1 contains:
Disk 2 contains:




Dept_Data.xls
Guidebook.doc


Tools (Folder)


Action Plan.xls


Activities Dictionary.doc


Memo to AS Employees.doc


Memo to Leadership.doc


Memo to Data Resources.doc


Org_Template.xls


PD Form.doc


Examples (Folder)


Example Activities Worksheets.xls


Example Org_Template.xls


Example PD Form.doc


Example Personnel Data.xls


Example Training Worksheet.xls

The tools are essentially templates that will guide and facilitate data assimilation.  They have been designed with on-line instructions to make data entry as convenient as possible.  The following pages provide more detailed instructions and background information to help you understand the data collection process.
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Families and Children

Department

Division

Branch

Auth-

orized

Filled

Unfilled

Financial 

Mgmt

Materials 

Mgmt

Support 

or 

Cyclical

Off. of Prgrm Support

N/A

N/A

5

4

1

Fincl. Mgmt

N/A

2

2

0

X

X

DSS/OPS Acct.

10

9

1

X

X

Payments

6

6

0

X

Ops & Res. Mgmt

N/A

3

2

1

Prop. & Supply

12

12

0

X

Facilities

14

13

1

X

X

Personnel/PFT's

AS Activities Checklist

Note: 

 These personnel work at the Purchasing Division level but 

not at any other level of the Administration Agency (e.g., Support 

Services Branch).  Likewise for personnel at the Oversight Division 

and the Administration Agency.

Note: 

 Consult the Activities 

Dictionary in the Guidebook for 

descriptions of activities.

Step 1: Develop an Action Plan

Immediately following your Course 1 training day, meet with the appropriate designated Agency Implementation Team members to establish an Action Plan for data collection.  A sample Action Plan has been provided at the end of this section.  An electronic copy of this example, Action Plan.xls, is saved on Disk 2 in the Tools folder.

The example Action Plan lists the eight primary data collection steps.  It then details for each step the data resources that are needed, tools that are provided, who will complete each task and the deadline for completion.  

Please use the template and the following steps as a guide to develop your action plan.

1. Open “Action Plan.xls,” found on Disk 2 in the Tools folder.

2. Enter the actual names for “Data Collection Resources.”

3. List “Who Will Complete Each Task.” 

4. Establish approximate dates for Team meetings to be held throughout the data collection process.  This will allow you to ensure that collection is going smoothly and on time.
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Employee:

Last Name, First Name

Basic Keyboarding

Windows 95

Microsoft 

Outlook

Smith, John

Beg. training, DIS, 

8/1/95.

Int. training, DIS, 

6/2/98.

Doe, Jane

Adv. training, DIS, 

5/14/97.

Note:

 Names have been copied 

from the Sample Personnel Data 

Worksheet.

Note:

 Enter information only when the Central AS Team 

requests it.  Enter relevant training of the last 5 years.
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Admin 
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Education, Arts, 
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Environmental 

Ed. Council

N

2

0

Financial mgmt 

performed by Doris 

Jones (Office of 

Secretary)

KET

Admin and 

Support

Business

N

18

6

KET

Admin and 

Support

Computers

KET

Admin and 

Support

Personnel

KCDHH (Deaf and 

Hard of Hearing)

Admin 

Services

Information

N

2

1

KCDHH  

Admin 

Services

Referral

KCDHH  

Admin 

Services

Advocacy

Arts Council

Executive

Administrative

N

3

2

Heritage Council

Fiscal Officer

N

1

1
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Society

Admin Support

N

5

2.5

Libraries and 

Archives

Admin 

Services

Fiscal Ops

N

1

7

Libraries and 

Archives

Admin 

Services

Admin Support

Libraries and 

Archives

Admin 

Services

Personnel 

Services

Teachers 

Retirement

Administration

Member Services 

Relations

N

5

10

Teachers 

Retirement

Administration

Comptroller 

Teachers 

Retirement

Administration

Data Processing 

Step 2: Consult with Agency Leaders

As you are aware, some employees in your agency, including leaders and data resources, are sensitive to discussions about organization design.  They are concerned about having their jobs reclassified or providing confidential information about employees.  Therefore, before collecting any of the data, you should contact your agency’s leadership to openly discuss the data collection process and its importance to MARS implementation, and to answer any questions they have about this phase of organization design.

To facilitate scheduling and conducting your meeting with agency leaders, you have been given two tools.  The first tool, Memo to Leadership.doc, is a sample memo that you may wish to send to the Cabinet Secretary or your agency’s Constitutional Officer to request a meeting.  It includes references to key deadlines and the data resources you will require.  It also asks leaders to send a memo to your key data resources, encouraging and authorizing them to take the time to assist in the data collection process.  Finally, it recommends that leaders send a memo to all Administrative Services employees informing them of the data collection process and what it means with respect to their jobs.  These activities will ensure that you and your resources are allotted the time and support needed to collect all data by October 15.

The second tool, Appendix B: Communications Toolkit, is located at the end of this Guidebook.  It provides “Talking Points” to help you plan the content of your memo and your meetings with leadership and data resources.  It also discusses the possible sensitivities some employees may have toward discussion of the organization design process.  Finally, it provides techniques and suggestions for navigating conversations about sensitive issues.

Following is a copy of the sample memo.  Please use it and the steps below as guides for communicating with your agency leaders.  

1. Open “Memo to Leadership.doc” in the Tools file folder on Disk 2.

2. Modify the names and content to better suit your agency.

3. Send the memo immediately.

4. Follow up with agency leaders to schedule a meeting.

5. Review Appendix B: Communications Toolkit.  Use the Talking Points to plan and prepare for your meeting.

6. Review Step 3: Inform Data Resources and Employees.  Adapt the sample memos to resources and employees so that they are appropriate for your agency.

7. Meet with agency leaders.  Convey to them the amount of time and human resources you will need in order to complete all data collection activities.  Request that a memo be sent to these resources encouraging and authorizing them to assist you as needed.  Also, recommend that a memo be sent to all Administrative Services employees to inform them of the data collection process.  

Note:  Be sure to take copies of the modified sample memos and your Action Plan to the meeting so that they are readily available for discussion and review.
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Employee:

Last Name, First Name

Basic 

Keyboarding

Windows 95

Microsoft 

Outlook

1)

 Enter the names of 

employees, or copy/paste the 

names from Personnel Data.

2)

 Enter the relevant training and experience in 

each category.  The categories correspond to the 

training index in Appendix D.
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Division

Branch

Employee:

Last Name, First Name

SUBTOTALS (FTE's):  

Financial Management

SUBTOTALS (FTE's): 

Materials Management

SUBTOTALS (FTE's): Cyclical 

or Support

SUBTOTALS (FTE's):

Non-Administrative

TOTALS (FTEs)

Uses KAPS

Uses STARS

Financial Mgmt

Payments

Thomas, Sue

0.30

0.00

0.20

0.50

1.00

X

Roberts, Bill

0.80

0.00

0.00

0.20

1.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

These columns are automatically 

copies from the Financial Mgmt 

Activities worksheet.

These columns are 

automatically copied from 

the respective activities 

worksheet.

This column sums all of 

the "Subtotal" columns.  

Check to be sure each 

row equals 1.0!

Step 3: Inform Data Resources and A. S. Employees

During your meeting with agency leaders, request that they send memos to all data resources and Administrative Services employees to inform them of the data collection process and what it means for them.  These memos should be sent out as soon as possible, before you begin data collection, so that individuals are prepared to take the time to assist you and provide you with the information you need.

Two sample memos have been provided for your reference.  The first, Memo to Data Resources.doc, provides data resources with an overview of the importance and requirements of the data collection process.  It also mentions the October 15 deadline for data submission and requests that you be provided with any time and assistance that you need to meet this deadline.

The second sample, Memo to AS Employees.doc, informs Administrative Services employees of the data collection process, where it fits into MARS implementation and organization design plans, and how to reach the Administrative Services Project Web site.  

Following are copies of the sample memos as well as recommended procedures for modifying them and preparing for meetings with your data resources.  Please use these as guides for generating memos for your agency leaders to distribute.

1. Open “Memo to Data Resources.doc” and “Memo to AS Employees.doc” in the Tools file folder on Disk 2.

2. Modify the names and contents in them as needed.

3. Submit them to agency leaders for distribution.

4. Prepare for your meetings with data resources.  Refer to Appendix B: Communications Toolkit for “Talking Points” and other suggestions.
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Tools

Data Collection Resources 

in Cabinet

Who Will Complete?

Due Date

1

Develop Agency Data 

Collection Plan

Guidebook 1,

Action Plan.xls

Department Heads/Mgrs.,

Personnel Administrator

Organization/Workforce 

Team

Now

Talking Points in Guidebook,

Memo to Leadership.doc

AIL (or designee, if 

several per Cabinet)

9/4/98

Talking Points in Guidebook

AIL (or designee, if 

several per Cabinet)

9/4/98

3

Inform Data 

Resources and A.S. 

Employees

Memo to Data Resources.doc

Memo to AS Employees.doc

AIL (or designee, if 

several per Cabinet)

9/4/98

4

Complete 

Org_Template

Guidebook 1,

Org_Template.xls, 

Module 1.3

Personnel Administrator,

Dept Heads/Mgmt, as needed

Implementation Team 

designee

9/14/98

5

Complete Personnel 

Data Worksheet

Guidebook 1, 

Dept_Data.xls,

Modules 1.3 & 1.4

Personnel Administrator,

Dept Heads/Mgmt, as needed

Personnel Administrator

9/14/98

6

Complete Activity 

Worksheets

Guidebook 1,

Dept_Data.xls,

Personnel Data Worksheet,

Module 1.3

Department Heads/Mgrs.,

Personnel Administrator, 

Evaluations, Position 

Descriptions 

(only if needed)

Implementation Team 

designee

10/15/98

7

Complete 

Training_Worksheet

Guidebook 1,

Training Worksheet,

Personnel Data Worksheet,

Module 1.4

Personnel Administrator,

GSC Liaison

GSC Liaison (Registrar 

Teaching System)

10/15/98

8

Submit Position 

Description Forms

Guidebook 1,

PD Form.doc, 

Module 1.4

Personnel Administrator,

Dept. Heads/Managers,

Activity Worksheet

Personnel Administrator

Managers

11/30/98

2

Consult with Agency 

Leaders

[image: image25.wmf]Sample Blank Personnel Data Worksheet

Division

Branch

Employee:

Last Name, First 

Name

Class 

Code

Class Title

Social 

Security 

Number

1)

 Enter the Division 

and/or Branch, as 

applicable, or enter N/A.

2)

 Enter the names of all employees 

who perform Administrative Services 

functions. 

3)

 Enter the current Class Code 

and Title for each employee.

4)

Enter the Social 

Security Number for 

each employee.
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Division

Branch

Employee:

Last Name, First 

Name

Class 

Code

Class Title

Social 

Security 

Number

N/A

N/A

Smith, John

9125

Fiscal Manager

444-33-2222

N/A

N/A

Doe, Jane

9227

Program Analyst Sr.

121-22-3333

Special Programs

N/A

Davis, Henry

9230

Program Manager

424-22-3333

Special Programs

N/A

Special Programs

Purchasing

Thomas, Sue

9243

Purchasing Agent

123-45-6789

Special Programs

Purchasing

Roberts, Bill

9235

Purchasing Technician

444-22-4444
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Education, Arts, 

and Humanities 

(cont.)
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N
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Fincl Services

Education Dept.
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Families and 
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Office of Program 

Support

Y
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distributed across the 

different divisions and 

branches

Office of Program 

Support

Fincl Mgmt

Budget planning 

and development

 

Office of Program 

Support

Fincl Mgmt

Payments

Office of Program 

Support

Fincl Mgmt

DSS/OPS acct.

Office of Program 

Support

Operations 

and Resource 

Mgmt

Employee 

services

Office of Program 

Support

Operations 

and Resource 

Mgmt

Facilities Mgmt

Office of Program 

Support
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Property and 
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Dept. of Facilities 

Mgmt

General Gvmt

Treasury

Gen Adm & 

Support

Admin Services

N

2

17

General Gvmt

Local Gvmt.

General Gvmt

Secretary of State

General Gvmt

Boards and 

Commissions

Not attached to any 

other administrative 

structure

General Gvmt

State Auditor

Office of 

Planning and 

Mgmt

 Records 

Management

?

2

2

State Auditor

Office of 

Planning and 

Mgmt

Fiscal

State Auditor

Office of 

Planning and 

Mgmt

Personnel
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General Gvmt 

(cont)

Judicial 
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System
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and Support

Acct, Support 
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0
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Military Affairs
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5
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Research 
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6
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Step 4: Complete Org_Template.xls

Purpose

The purpose of the Org_Template is to guide you in preparing a baseline assessment of agency structures and functions and to help you understand the scope of administrative services activities within your agency.

Resources Needed

In order to complete this worksheet, you may need to consult:

Organizational Chart

· Personnel Administrator

· Office/Department Heads

· Division/Branch Managers

Tools and Examples
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Org_Template.xls is a Microsoft Excel file located in the Tools folder on Disk 2.  An example blank worksheet is included below.  A completed worksheet is shown at the end of this section.  Both of these templates are also available in the file named Example-Org_Template.xls, found on Disk 2 in the Examples folder.  For additional examples, please refer to the Module 1.3 slides that were given to you during training.  If you require assistance with Microsoft Excel, please consult Appendix E: Software Assistance Guide.

Procedure

The procedures for completing this template were briefly described during training Module 1.3.  Those abbreviated procedures have been broken into a number of more detailed steps for you here.

1. Review Appendix A: Administrative Services Activities Dictionary to become familiar with the categories of activities.

2. Obtain current organizational charts for the departments you are assisting.

3. Open the Microsoft Excel file, Org_Template.xls, located on Disk 2 in the Tools folder.  

Note:  In the right corner of each cell of data, you will notice a red triangle.  This indicates that the cell contains instructions for your convenience.  To see these instructions, click on the cell.

4. Referring to the organizational chart(s), enter names for each Department, Division and Branch in Columns 1-3.  Be sure to list at least those organizational levels in which administrative services functions are performed.  If there are no applicable divisions or branches, type “N/A” in those columns.

5. The remaining steps involve listing those individuals within each organizational unit who perform administrative services functions.  To complete these steps, you may need to set up meetings with the Personnel Administrator, department heads, division managers or branch managers.  

For guidance in conducting these meetings, please reference Appendix B: Communications Toolkit.  Bring printed copies of this worksheet on which you can quickly write information.  You may also wish to print copies of Example-Org_Template.xls and the Activities Dictionary.  For your convenience, a copy of the dictionary has been saved as Activities Dictionary.doc on Disk 2 in the Tools folder.

6. Enter the number of positions Authorized (i.e., budgeted), Filled and Unfilled at each organizational level in Columns 4-6.  Begin at the lowest level within the organization (e.g., the Branch level in the sample worksheet).  Enter the correct number of personnel, regardless of whether they perform administrative services functions.  Proceed to the next highest level within the organization and enter the number of personnel that support that level but are not a part of other organizational levels within the agency. Continue this process until you have accounted for all personnel in all relevant organizational units.  Be sure that you do not double-count any individual; only list each person once – at the level at which he/she is actually employed.
7. In Columns 8-10, indicate those organizational levels in which administrative services functions are performed.  Place an “X” under the appropriate category - Financial Management, Materials Management and Support/Cyclical – that describes the administrative activities that are performed.  You may need to refer to Appendix A: Activities Dictionary for definitions of these categories.

8. Save the file.

9. Submit the file on a diskette or by e-mail to Gail Prewitt (gprewitt@mail.state.ky.us or 502-564-4240) by September 14.
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* FTE numbers were collected from the agencies in November 1997. Changes should be noted and sent to Gail Prewitt by October 15, 1998



[image: image31.wmf]Blank Financial Mgmt Activities Worksheet

Division

Branch

Employee:

Last Name, 
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Administrative: Financial 

Management Activities

1099 Processing

Accounting

Cash Receipts/Management
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0.00

0.00

0.00

0.00

0.00
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1) 

Copy these columns from 

columns A-C of the Personnel 

Data Worksheet.
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Click on the "+" sign to 

see specific activities.
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 Click on the "-" sign to 

hide the activities again.
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Enter % FTEs (on a scale 
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7)

 Enter comments to 

describe any activities 

you have added.

Step 5: Complete the Personnel Data Sheet

Purpose

The purpose of the Personnel Data worksheet is to guide you in listing all of the individuals who perform administrative services activities within your agency.  For these individuals, you will be collecting a name, Social Security Number, Class Code and Class Title.

Resources Needed

In order to complete this worksheet, you may need to consult:

· Personnel Administrator

· Office/Department Heads

· Division/Branch Managers

· Completed Org_Template.xls

Tools and Examples

The Personnel Data worksheet is located in the Microsoft Excel file labeled Dept_Data.xls, which is a large file that takes up all of Disk 1.  The following is an example of a blank Personnel Data worksheet.  An example of a completed worksheet is provided at the end of this section.  Both examples are also included in Example-Personnel Data.xls in the Examples folder on Disk 2.
For additional examples of this worksheet, please consult the Module 1.3 and 1.4 slides that were given to you during your training.  If you need help with Excel, see Appendix E: Software Assistance Guide.
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Division

Branch

Employee:

Last Name, 

First Name

Administrative: Financial 

Management Activities

1099 Processing

Accounting

Cash Receipts/Management

Develop/maintain methodologies
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Note:

  You do not have to enter 0 if no 

time is spent on this activity; just leave 

cell blank.

Note:

  If you do add an activity, be sure to give 

it a descriptive name and detail it in the 

"Comments" column.

Note:

  This column sums the 

percentages of Financial Management 

FTEs entered for each employee.


Procedure

The procedures for completing this template were briefly described during the training Modules 1.3 and 1.4.  As mentioned at that time, there are two alternatives for collecting this data.  It does not matter how you collect the data, but the data must be submitted in the Personnel Data worksheet that has been provided for you.

Note:  If you are collecting data for more than one office/department, you will need to follow these procedures and create a new file for each one.

Alternative 1: Enter data manually.

1. Open the Microsoft Excel file, Dept_Data.xls, located on Disk 1.

2. Save the file onto your hard drive using the filename “###_Data.xls,” where ### includes the name of your agency and department (e.g., F&C-Program Support_Data.xls, Justice-Office of Sec_Data.xls).  

3. In Columns A and B, enter the names of all Divisions or Branches in which employees perform administrative services functions.  Use your completed Org_Template.xls as a reference.  If an employee works for a Division but not a Branch, enter “N/A” for the Branch.  Similarly, if an employee works for the department, but not a Division or Branch, enter “N/A” in both the Branch and Division columns.  

4. In Column C, enter the name of each employee who performs administrative services functions at that organizational level.  Enter the last name first, then the first name.

5. In Columns D and E, enter the current Class Code and Class Title for each employee.

6. In Column F, enter the Social Security Number for each employee.  This information will remain confidential!  It will be used to retrieve previous position descriptions and training information from the Personnel Cabinet, as needed.  Please contact Gail Prewitt if you wish to discuss alternatives to submitting the Social Security number.

7. Save the file.

8. The file(s) will probably be too large to save on a diskette, so please submit the file(s) by e-mail to Gail Prewitt (gprewitt@mail.state.ky.us or 564-4240) by September 14.

Alternative 2: Ask the Personnel Cabinet to provide this data in an ASCII file.

1. Contact Commissioner Joan Walker (502-564-2428) to see if the Personnel Cabinet can provide you with an ASCII file containing the names, class codes, class titles and social security numbers of all employees within your agency or department.

2. Import the file into Microsoft Excel.  Refer to your Microsoft Excel manual for instructions on importing ASCII files.

3. Open Dept_Data.xls, located on Disk 1.

4. Save the file onto your hard drive using the filename “###_Data.xls,” where ### includes the name of your agency and department (e.g., F&C-Program Support_Data.xls, Justice-Office of Sec_Data.xls). 

5. Move to the Personnel Data worksheet within this file.

6. Cut and paste into the Personnel Data worksheet the information from the ASCII file provided by the Personnel Cabinet.  Note:  The ASCII file will contain information about all employees, not just administrative services employees.  You should include in the Personnel Data worksheet only those individuals who perform administrative services functions.  

7. Save the file.

8. The file(s) will probably be too large to save on a diskette, so please submit the file(s) by e-mail to Gail Prewitt (gprewitt@mail.state.ky.us or 564-4240) by September 14.



Step 6: Complete the Activities Worksheets

Purpose

To thoroughly document the administrative services activities performed by each employee in the Personnel Data sheet.

Resources Needed

In order to complete this worksheet, you may need to consult:

· Personnel Administrator

· Office/Department Heads

· Division/Branch Managers

· Personnel Data Worksheet

· Other levels of management, depending on the size and complexity of your agency and the sensitivity of managers to completing this information.

Tools and Examples

The Activities Worksheets are located in the Microsoft Excel file labeled Dept_Data.xls located on Disk 1.  There are four Activities Worksheets, labeled as follows:

· Financial Management Activities

· Materials Management Activities

· Other Activities (Cyclical, Support, Non-Administrative)

· Activities Summary

The following is an example of a blank Financial Management Activities worksheet.  Examples of a completed Financial Management Activities worksheet and Activities Summary worksheet are included at the end of this section.  All of these examples are also available on Disk 2 in the file named Example-Activities Worksheets.xls.  For additional examples, please consult the Module 1.3 slides given to you during training.  If you need help with Excel, refer to Appendix E: Software Assistance Guide.

Procedure

The procedures for completing this template were briefly described during training Module 1.4.  Those abbreviated procedures have been broken into a number of more detailed steps for you here.

1. Open the Dept_Data.xls files that you created for each department during Step 5: Complete the Personnel Data Sheet.

2. Click on the tab labeled “Personnel Data.”  


3. Highlight and copy Columns A, B and C (Divisions, Branches and Employee Names).

4. Click on the tab labeled “Financial Management Activities.”

5. Highlight and paste into Columns A, B and C (Divisions, Branches and Employee Names).  This will automatically paste this data into all of the Activities worksheets.
6. If you are not certain about the specific activities that each employee performs, schedule meetings with Agency Heads and/or appropriate Division and Branch Managers who oversee administrative services activities.  Consult Appendix B: Communications Toolkit for recommendations on conducting these meetings.  Do not use the old PD forms to complete these forms.  It is critical to have accurate data.
Bring numerous blank copies of the activities worksheets to the meetings to facilitate data collection.  Blank activities worksheets were handed out during your training and should be located in your Course 1 Manual behind the green tab labeled “Handouts” and the green sheet labeled “Templates.”

7. For each employee, enter the percent of time spent on specific administrative services activities.  Use a scale of 0 to 1, where an entry of 1 means that the employee spends 100% of his/her time on that activity.  You DO NOT need to enter a 0 for activities that are not performed.  If an employee spends less than 1% of his/her time on administrative services activities, you do not need to enter this information under a specific activity.  Instead, please type a comment in the “Comment” column located at the right of each activities worksheet.

You will need to move back and forth between the Financial Management, Materials Management and Other Activities worksheets.  The Other Activities worksheet contains Cyclical and Support administrative services functions as well as non-administrative services functions.

Activity categories (e.g., Accounting, Accounts Receivable) are listed along the tops of the worksheets in green shaded columns.  These column labels correspond to the main (bold) categories of activities listed in Appendix A: Activities Dictionary.  DO NOT enter data in these shaded columns.  Instead, click on the “+” above each column to see a list of specific activities.  Enter data in the white cells of these columns.  When you are finished entering data, you may wish to click on the “-“ sign above the column to again hide these rows and make the worksheet more manageable.

If you find that an employee performs a supervisory activity that you do not see listed, you will need to add and describe the activity.  There is a column labeled “Supervisory Activities” included in each Activities worksheet.  Click on the “+” above this column to show several blank columns.  Highlight one of the cells that says “Blank” and type in the name of the supervisory activity.  Enter the percentage FTE the employee spends on this activity.  Then, move to the “Comments” column at the far right of the worksheet and enter a more detailed description of the activity.

If you find that an employee performs an activity that is not listed, please insert a new column under the sub-category “Add Activities” that is located at the right side of your worksheet just before the “Sub-Total FTEs” column. Then, move to the "Comments” column located to the right of the “Sub-Total FTEs” column.  Type in a specific description of the activity that you have inserted.

If an employee spends time doing non-administrative services activities, enter the correct percentage of time in the column labeled “Non-Administrative Activities” found in the Other Activities worksheet.

8. Validate your results.  Each row in the Activities Summary worksheet should sum to 1.0 in the “Total FTEs” column.  If it does not, you have accounted for more or less than 100% of the employee’s time.  Recheck the values that you have entered and modify them until the row sums to 1.0.

9. In the Activities Summary worksheet, please place an X in the appropriate column if the employee uses KAPS or STARS.

10. Save the file.

11. Submit the file on a diskette or by e-mail to Gail Prewitt (gprewitt@mail.state.ky.us or 564-4240) by October 15.





Step 7: Complete the Training Worksheet

Purpose

To document the relevant training and experience each administrative services employee has had in the past five years.  This information will help you to identify the types and scope of training that will be needed prior to MARS implementation.

Note:  This information was previously collected for most employees during an October 1997 survey.  The Central Administrative Services Team will use the Personnel Data sheets you have provided to determine if they have data on all A. S. employees in your agency.  If they need additional data, they will contact you by September 30.

Resources Needed

In order to complete this worksheet for each employee, you may need to consult the:

· Appendix D: Training Index

· Personnel Administrator or other GSC Liaison

· Employee Records

Tools and Examples

The Training worksheet is located in the Microsoft Excel file labeled Dept_Data.xls in the Tools file folder on Disk 2.  The following is an example of a blank Training worksheet.  An example of a completed worksheet is provided at the end of this section.  For additional examples of this worksheet, please consult the Module 1.4 slides given to you during training, or refer to the Example-Training Worksheet.xls file located on Disk 2.  

In order to complete the Training worksheet, you will need to review the Training Index in Appendix D of this Guidebook.  This index lists the types of training and experience that are considered relevant to MARS implementation and organization design.

Procedure

1. Review Appendix D: Training Index to become familiar with the types of training and experience that are considered relevant to this project.  

2. Open the Dept_Data.xls file(s) that you created in Step 5: Complete the Personnel Data Sheet.

3. Click on the tab labeled “Personnel Data.”

4. Highlight and copy Column C (Employee Names).

5. Click on the tab labeled “Training.”

6. Highlight and paste into Column A (Employee Names).

7. In Columns B through M, enter the relevant training and experience that each employee has had in the last five years.  The categories in these columns correspond to those listed in Appendix D: Training Index.  Enter data only for those employees that the Central A. S. Team has indicated.  When possible, indicate both the source and date of the training.

8. Save the file.

9. Submit the file on a diskette or by e-mail to Gail Prewitt (gprewitt@mail.state.ky.us or 564-4240) by October 15, or as soon as possible after being notified by the Central A. S. Team.


Step 8: Submit a Position Description Form

Resources Needed

In order to complete this worksheet for each employee who does not have a current PD form, you may need to consult the following:

· Personnel Administrator

· Personnel Data Worksheet

· Activities Worksheets

Tools and Examples

The most recent revision (August 1998) of the Position Description Form is located in the Microsoft Word file labeled PD Form.doc on the Course 1 diskette.  An example of a completed form is provided at the end of this section.

Procedure

As mentioned during the Module 1.4 presentation, this form has been modified and may have a slightly different layout than the form to which you are accustomed.  Most notably, the new form has been created in a way that facilitates data entry by computer.  You may still print out the form and manually type or write in the required information.  However, it is preferred that you open the file on your computer and electronically enter the information for each employee.

Please refer to the following instructions to assist you in completing the new form for each employee.  If you need assistance with Microsoft Word, please refer to Appendix D: Software Assistance Guide.

1. Open the Microsoft Word file, PD Form.doc, located in the Tools folder on Disk 2.

2. If you are completing the form electronically, save the file as ###.doc, where ### is the social security number of the employee.  Then use the <TAB> key or mouse to move from box to box as you enter data.

If you are completing the form manually, print out the form and complete the following steps with a pen or typewriter.

3. In the top row of the form, beginning with the box labeled “Cabinet”, enter the numeric codes for each category.

4. For Question 1 “Nature of Request”, enter “Other: A. S. Baseline.”

5. For Question 2, place an “X” in the box beside the type of position the employee holds – Full-time, Part-time or Interim.

6. For Question 3, enter the Class Title and Class Code for the employee’s current position.  This information can be found in the Personnel Data Worksheet that you completed in Step 5.

7. DO NOT enter any information for Question 4 “Proposed Title Code and Title.”

8. For Question 5 “Name of Incumbent,” enter the name of the employee.

9. For Question 6, enter a brief description of the employee’s current position.  Use the information collected in the Activities Worksheets to help you summarize the position.  This description should consist of up to five statements.

10. For Question 7, list those activities on which the employee spends most of his/her time.  Again, refer to the Activities Worksheets and list the activities that coincide with the highest FTE percentages.  When needed, round to the nearest 10%.  Descriptions should consist of up to seven statements.

11. For Question 8, indicate whether the employee conducts employee appraisals on subordinate employees.  If so, list the class titles and codes of the supervised employees.

12. For Question 9, indicate whether the current position requires the incumbent to perform any of the essential functions identified in the Americans with Disabilities Act (ADA).

13. For question 10, type or sign your name and enter the date and your current title.

14. If you have completed the form electronically, save the file and submit it on a diskette or by e-mail to Gail Prewitt (gprewitt@mail.state.ky.us or 564-4240) by November 30.  

If you have completed the form manually, submit a hard (printed) copy of the form to Gail Prewitt by November 30.

KENTUCKY PERSONNEL CABINET
Revised 8/1/98

 POSITION DESCRIPTION (PD)














Cabinet

Department

Division

Branch

Section

Unit

Employee

39

758

02

07

01

00

009

1.
Nature of the request: 
 FORMCHECKBOX 
Establishment
 FORMCHECKBOX 
Reclassification
 FORMCHECKBOX 
Reallocation
Other
A. S. Baseline

2.
X Full-time
 FORMCHECKBOX 
Part-time 
 FORMCHECKBOX 
Interim



3.
Current Title Code and Title
9107 - Accountant I

4.
Proposed Title Code and Title
     

5.
If filled, name of incumbent
Jane Smith

6.
Statement of Duties: Briefly state the main function of the job.  Do not write more than two statements. 


Performs beginning level technical work in the maintenance of accounting and financial records and 


Performs other duties as required.

7.
List up to seven (7) primary tasks and duties performed by the position.  Begin with the most important duty.  Be specific as to the duties and responsibilities of the position.



Average % of Time



a.
Posting, balancing and reconciling accounting records either manually or by data

40%



processing methods.  .




b.
Processing financial transactions, disbursements, receipts, expenditures and fund

20%



transfer requests.




c.
Assist professional staff in preparing and maintaining accounting systems.

15%



     




d.
Preparing payroll.

15%



     




e.
Preparing tax return audits and tax refunds.

5%



     




f.
Preparing financial schedules.

5%



     




g.
     

     



     





TOTAL

100%


8.
Does the incumbent of this position conduct performance appraisals on subordinate employees?
 FORMCHECKBOX 
Yes
XNo


If yes, please list the class title(s) and number of positions in each class, or title and number of contractual employee(s):  










9.
Are there any essential functions of this position that require an incumbent to:

This indicates the essential functions of an incumbent for Americans with Disabilities Act (ADA) to ensure communication accessibility for individuals with visual and speech impairments.  NOTE: IF THIS JOB DOES NOT REQUIRE THE ESSENTIAL ELEMENTS LISTED BELOW, DO NOT CHECK.


 FORMCHECKBOX 

(A) Drive a licensed vehicle?



 FORMCHECKBOX 

(B) Use a firearm?



 FORMCHECKBOX 

(C) Lift heavy objects or work in  uncomfortable positions for extended periods of time? 



 FORMCHECKBOX 

(D) Be exposed to hazardous working conditions?



 FORMCHECKBOX 

(E) Frequently communicate in person or by telephone? 



 FORMCHECKBOX 

(F) Spend a major portion of time using a keyboard? 



 FORMCHECKBOX 

(G) Be exposed to any hazards such as  traffic or persons with contagious diseases?



 FORMCHECKBOX 

(H) Visually inspect documents and/or activities & make decisions from those inspections?



 FORMCHECKBOX 

(I)  Other -- please describe 
     



     




     


10.
SUPERVISOR
I certify that the information listed above is, to the best of my knowledge, complete and accurate, and if the position is filled, the employee has reviewed the information contained herein.

Signature of Supervisor
John Doe
Date
11/01/98

Title of Supervisor
Accountant IV



NOTE: If submitted electronically, typed name serves as signature.  If the position is filled, do not submit the PD form until it has been reviewed by the employee. It is no longer necessary for the employee to sign the PD since the job duties are assigned by the supervisor.  KRS 12.060 states in part "All departments to such positions shall be under the supervision, direction and control of the heads of the respective departments and shall perform such duties as the heads of the departments prescribe."

FOR PERSONNEL CABINET PROCESSING ONLY:










ANALYST


DATE


APPROVED CLASS









DENIED



The Commonwealth of Kentucky does not discriminate on the basis of race, color, national origin, sex, religion, age, political affiliation or disability in employment or the provision or services.  This document is available in an accessible format upon request to the Division of Classification and Compensation, Kentucky Personnel Cabinet.

Appendix A: Administrative Services Activities Dictionary

This appendix provides a list and definitions of administrative services activities.  The list corresponds to the activities shown at the tops of the Activities Worksheets, completed in Step 6.  It should be used as a resource in completing all of the templates and worksheets described in this Guidebook and provided on the Course 1 training diskette.

The list is divided into three main groups of administrative services activities: Financial Management, Materials Management, and Cyclical/Support functions.  The list is intended to encompass most activities.  However, due to the varied nature of activities in each Cabinet, some agency-specific functions may not be included.  Therefore, spaces have been added in the templates to allow you to enter unique activities.  Please be as specific as possible in describing any added activities.

Financial Management Activities

Generally, financial management activities include processes related to planning and budgeting, conducting intra-agency transactions, general accounting procedures, accounts payable, accounts receivable/cash receipts, and management reporting and decision support.  

The following specific activities have been provided to help you classify employees who are performing administrative services in your agency.  Where applicable, we have provided descriptions and indicated the Division of Accounting (DOA) forms that are associated with each activity.  

These activities coincide with those listed at the tops of the Activities Worksheets in Dept_Data.xls.  Blank columns have been included in the worksheets so that you may indicate activities that are performed in your agency but do not appear on this list.

Activity
Description/Related DOA Forms

1099 Processing


Maintain 1099 reporting info
Includes merging reporting info from non-STARS systems w/STARS info

Agency record verification
Twice annual process of verifying 1099 information with agencies…time consuming because of form mailing volume

Compile/submit reports to IRS


Research IRS regulations


Handle vendor/IRS inquiries


Activity
Description/Related DOA Forms

Accounting
The majority of these functions are performed centrally. The Transportation Cabinet is one notable exception to this trend.

Research acct. principles


Prepare accounting entries
Daily data entry. Either batch, interfaces, direct input, or document processing

General Ledger data input
Can also include balancing of the General Ledger. This activity is generally concerned with producing transaction/data summaries. 

Develop acct./fincl. systems
DOA-14; Performed in conjunction with programmers- can be either systems of accounts or automated systems

Maintain charts of accounts
Can relate to the on-line update process. Personnel both at the agency and central levels perform this "table maintenance" on PC.

Maintain financial system reference tables


Develop policy/procedure manuals
Primarily a management activity.

Train end users
Can involve training of field/agency employees when a process is changed centrally.

Enforce GAAP/statute compliance


Develop/maintain business forms
Many agencies have internal accounting forms which they must both update and reconcile with forms required centrally.

Payroll Processing
DOA-27 ONLY; Specifically, one-time payments on manual vouchers. For example, crediting an employee for unused vacation time if he/she leaves state government.

Pre-Audit Processing
DOA-59, 60

ProCard Processing
DOA-65 ONLY

Supervise clerical/professional staff


Analyze proposed business policies


Handle internal inquiries
Support the questions/needs of mgmt, legal staff, programmers, and end users

Handle external inquiries
Includes auditors, grantors, media, Finance, vendors, customers

Accounts Receivable
DOA-2; Very few agencies perform receivable tracking functions in a decentralized fashion.

Develop/maintain tracking systems 
Can be either agency or mainframe applications. For example, The Student Loan Group's mgmt team has developed a particularly innovative and effective tracking system.

Develop/maintain policies/procedures


Enter Data (Sales/Transaction)


Print/Distribute billing statements


Age outstanding receivables


Print/distribute delinquent notices


Activity
Description/Related DOA Forms

Accounts Receivable (cont)


Respond to customer inquiries


Print/distribute re-bill requests


Recommend adjustments/write-offs


Asset/Liability Management Processing 
These activities related to the recently formed Asset/Liability Commission.

Coordinate asset assignment
Administrative role that involves assigning a capital asset to a person, room, office, etc.

Monitor/track fixed asset repair costs
Involves some data entry.

Develop/apply depreciation methodology


Record/maintain asset insurance info


Coordinate maintenance/repair activity


Support equipment/supply purchasing
Can involve analysis and/or work directly with Purchasing dept. to identify fixed asset and operational supply needs

Maintain fixed asset tracking system
Can be agency or mainframe application

Periodic inventory of fixed assets


Develop/apply cost recovery methodology
This relates specifically to fixed assets. This activity is very important for agencies like DIS and Human Resources, who must recover federal costs on certain grants.

Coordinate cost recovery billings
For capitalized leases.

Update fixed asset systems for acquisitions


Complete fixed asset 'shell' record 
This is produced by STARS and submit to Finance

Assign tag number, assigned location and individual


Manage asset 'swaps' for component replacements
This is done under manufacturer warranties

Surplus Property


Track manufacturer warranties and maintenance agreements


Reconcile agency asset systems with STARS 
This is done for acquisitions and disposals

Coordinate disposal of fixed assets
(e.g., sale, junk, transfers, cannibalize)

Create statutory, regulatory and policy statements 
Do this for fixed asset management

Coordinate financial reporting with GASB and GAAP 


Cash Receipts/Management


Develop/maintain policies/procedures


Sort/open incoming mail


Prioritize work remittances for processing


Match payment with remittance


Activity
Description/Related DOA Forms

Cash Receipts/Management (cont)


Catalog/Number remittance and receipt


Endorse remittance checks


Update customer/taxpayer records 


Fund transfer (local to central)
Processing of funds from local bank to central repository (conducted by field office)

Determine proper accounting distribution
The process of determining and then allocating the correct distribution of funds from certain taxes ( I.e. coal severance)

Prepare and route deposit
Either to Treasury (Frankfort) or local banks

Track/Reconcile deposits-in-transit


Process NSF checks


Cost Allocation


Develop/maintain methodologies


Develop/maintain support systems 
Either agency or mainframe applications

Review cost allocation reports


Handle auditor compliance/inquiries
State and/or federal

Debt Recording and Servicing Activities


Record debt


Service debt


Refinance debt


Retire debt


Account for re-investment of bond monies


Account for expenditures using debt money


IRS arbitrage reporting


Encumbrance/Obligation Processing (post awards processes)
DOA-56; These are also referred to as "Contract Documents". 

Record/Input encumbrance/obligation transaction


File contract/MOA


Monitor vendor invoices
To ensure contract compliance and verify contract balance

Resolve discrepancies with vendor


Initiate change-order requests
Includes filing a "Change Order" form. Usually occurs during end-of-year- reconciliation of books.

Originate payable transactions


Liquidate unexpended encumbrance funds
Performed at contract end. Includes PC data entry/maintenance/updating.

Activity
Description/Related DOA Forms

Error Correction Processing (STARS)


Review/resolve suspended transactions
Note: Some agencies allow on-line corrections. Includes the daily activity of correcting any transactions that STARS places in a Suspend file. 

Coordinate changes with Finance
For agencies who opt to have a central liaison make the changes for them. Involves telephone and/or electronic communication.

Grant and Project Management
Federal Grants, Transportation Projects, Capital Projects.  DOA-5, 24, 25, 25A, 37, 40A, 40B, 43, 44.

Grants/Federal Draws


Transaction Input/Data Entry
The daily activity of entering new data/ updating existing data on the agency or mainframe computer system.

Maintain reference tables


Enforce grant provision compliance


Create/distribute grant reports 
Includes those agencies that use central report version and those who also use a custom version.

Develop CMIA compliance criteria
This process involves gaining US Treasury approval and creating an annual agreement

Develop/maintain program logic
To ensure/support compliant cash draws from federal agencies

Perform annual CMIA compliance analysis
Process performed in conjunction with fed government to determine, at year's end, if any money is owed by either party.

Create federal schedules of activity
To support annual federal compliance audit. This is also known as "the single statewide audit".

Assist auditor during review


Respond to audit inquiries


Imprest Cash
DOA-13, 16, 17, 18, 46, 47, 57

Invoice receipt/validation
Match invoice to agency records to capture vendor, payment amount, and receipt of good/service 

Prepare forms/Assemble voucher


Route to imprest clerk/custodian


Perform payment pre-audit
Mgmt activity to review/approve payment request

Create file for STARS upload


Reconcile bank account


Control check stock
Any activity related to ensuring that all checks are accounted for by number and dollar amount. Also to ensure no checks are missing.

Enforce appropriate internal use of fund
Assist programmers/mgmt with imprest cash policies/procedures

Internal/External Billing
DOA-7 (Inter-account bill)

Create IA Billing


Aprove billing (both agencies)


Enter/Track IA transactions


Activity
Description/Related DOA Forms

Intra-Government Transactions
DOA-7, 8, 9, 66

Investment Income Apportionment


Investments/Loans
DOA-20; In general, the daily management of excess cash. Conducted primarily by Finance, Treasury, Kentucky Retirement Systems, and Teachers Retirement System

Investment data entry/tracking
Recording of investment sale/purchase and changes. There are specific forms related to this activity.

Calculate/Distribute interest earnings


Recommend Investment Purchase/Sale
A mgmt activity centrally.

Journal Vouchers
DOA-1, 1B ; All JV transactions are ultimately routed centrally.

Verify JV transactions (other agencies)


Process/Input JV corrections
Some arrive electronically; others in hard copy.

Management Budgets (Budget Execution)
Allotment and Appropriations (DOA-3, 4).  Planning (DOA-49, 49A).

Track budget use vs. actual
Data entry performed at both the agency and GOPM.

Recommend account chart changes


Research related to budget


Monitor/Analyze budget
Mgmt. Activity at all levels: office, division, dept., cabinet, and statewide

Prepare/justify budget modification requests
Once the request is drafted, it is sent from the agency to GOPM for authorization and then to LRC for final approval

Management/Financial Reporting


Develop and maintain reports
Includes the process of compiling actual data in PC applications.

Train users on report use


Process open-records requests


Prepare custom reports for mgmt


Payments (central issued checks)
Travel, Vendor, Services, Grants.  DOA-19, 28, 28A, 29, 30, 31, 34, 35, 40, 48, 48A, 51, 52.

Receive/Validate Invoices


Determine proper acct. distribution


Prepare forms/assemble voucher


Transaction Data Input (STARS/KAPS)


Route for approvals


Perform central pre-audit review


Respond to inquiries (vendor/auditor)


Issue Warrants
Ensure formal authorization for Treasury to issue checks.

Write/Distribute Checks


Activity
Description/Related DOA Forms

Records Retention/Archival


Develop/maintain policies/procedures


Develop transaction numbering procedures
Linkage of automated transaction with hard copy support

File voucher records


Control record access


Microfilm records


Archive records


Coordinate record destruction


Refund Processing
DOA-26, 26A; Primarily associated with the Revenue Cabinet. If, for example, sales tax is received erroneously, a refund is identified, a document processed, and a refund check mailed. 

Request for Approval of Bank Account
DOA-54; Any activity (data entry or mgmt) related to temporary (less than one month) deposits in local banks (outside Franklin County). 

Revenue Estimating


Analyze quarterly DRI data
Any activity associated with OFMEA's receipt of national economic data and its use for Kentucky revenue projections/schedules.

For budget projections


For agency use only


STARS 


Reconcile agency data to STARS data
The task of making sure STARS reports are balanced with central and agency reports.

Security-Access Request
DOA-64

Authorize system clearance level
Tasks related to deciding what level of access a particular employee should have to electronic information( View, Update, or Input).

Adjust system for clearance level
Any manual/electronic changes needed to allow end users the capabilities granted heretofore by mgmt.

Straight Disbursements
Payments which do not need a purchase order or to go through approval process (e.g., payment to counties of their portion of certain taxes that have been collected). DOA-19, 19R.

Vendor Offset/Intercept
DOA-67; Joint-agency activity that allows revenue collecting agencies to "latch" on to vendor payments. For example, when a vendor hasn't paid taxes. 

Create list of delinquent vendors


Coordinate joint collection effort
Any activity related to assisting agencies with revenue collection via "latching". Most applicable to Revenue Cabinet, Families and Children, and Employment Services.

Activity
Description/Related DOA Forms

Vendor Processing
File Maintenance (DOA-58).  Electronic Funds Transfer (EFT) Requests (DOA-63).

Establish vendor file
Activities related to  the opening of a vendor file including inputing vendor name, address, etc.

Vendor Table Maintenance-Agency Level


Obtain vendor master information


Data Entry- Vendor Records


Vendor Table Maintenance-Central


Control vendor record editing


Create pre-note for ACH verification


Wire Transfer Warrant
DOA-36A, 62

Print/Distribute report to Treasury


Related approvals


Agency's Program Management


Develop/maintain agency program support systems


Reconcile support systems to STARS 


Develop/maintain system's produced reports


Handle internal/external inquiries


Payroll


Develop/maintain time & attendance procedures & policies


Maintain labor distribution systems


Handle internal/external inquiries


Coordinate W-2 reporting


Coordinate garnishment and non-voluntary withholding


Distribute employee payroll checks/EFT stubs


Coordinate voluntary withholdings
Refers to employee, payroll systems and third party recipients (e.g., credit union, insurance companies, cafeteria plans, etc.)

Report employee time and attendance


Material Management Activities

Generally, material management activities include processes related to planning, vendor management, ordering, receiving, inventory, disposal, personal services contracts and Pro-Card.  

The following specific activities have been provided to help you classify employees who are performing administrative services in your agency.  Where applicable, we have provided descriptions and indicated the Division of Accounting (DOA) forms that are associated with each activity.

These activities coincide with those listed at the top of the Activities Worksheets in Dept_Data.xls.  Blank columns have been included so that you may indicate activities that are performed in your agency but do not appear on this list.

Activity
Description/Related DOA Forms

Create Purchase Requisition
DOA-32

Determine items and specs


Create requisition header (KAPS)


Enter appropriate data
Commodity codes, estimated cost per item, specs, terms and conditions,etc.

Post for approval (KAPS)


Bid Tab


Enter data (each bid response)
Activity related to Screen 2320. This process includes entering the invitation or requisition #, delivery date, vendor ID, unit cost per item, and also entering note regarding any discrepancies

Batch entire job
Includes printing of above data and including with bid package and requisition.

Bid 


Create/Route requisition
Can either be forwarded by agency to Finance/Purchasing or can be created by DOP buyer

Review/Approve requisition
Mgmt activity typically performed by Assistant Directorr. Includes forwarding of requisition to appropriate buyer.

"Clean up" requisition
Performed by buyer on KAPS. This step may require text processing.

Link requisition to IT screen
The buyer's responsibility: intitating the link from KAPS to IT.

Determine bid method
Price contract or single purchase.

Create Invitation for Bid
Screen 2311

Activity
Description/Related DOA Forms

Bid (cont)


Perform due diligence
Any activity related to deciding whether bid will be advertised, whether EEO procedure applies, and/or whether Contract Compliance review is necessary (over $250K)

Enter requisitions associated with bid


Select vendors
Includes both incumbent vendors and agency's sugested vendors

Print label sets
This activity includes printing both lable sets and saving electronically.

Select terms & conditions
Chosen from standard terms

Compile /Post invitation (KAPS)
Ensuring that requisition is attached to t&c, labels, and data sheet.

Prepare invitation format
Usually done by bid tech.

Deliver hardcopy to buyer
Usually done by bid tech.

Copy/Mail bid
Coordinated by file room- to include attachments.

Post bid
Post the bid to Internet from KAPS

Conduct pre-bid conference
If necessary, conducted and planned prior to bid opening.

Prepare bid addenda
Intermediate step, if conference or vendor inquiries dictate immediate changes.

Record price quotes in KAPS
Done by bid tech after bid opening

Read bid publicly


Contract Award


Evaluate bids
Note: Alternate bids need to be approved.

Determine best value bidder


Determine eligibility of vendor


Select winning bid(s)
By commodity, vendor, subtotal

Create PO/contract


Complete bid recap sheet
Document reasons for award and, in case of price contract, add terms and conditions.

Print/Review/Authorize (Buyer) 


Review/Authorize (Supervisor)
Sign hardcopy

Distribute/Log Award
Usually done by bid tech.

Track and resolve protests


Contract Administration


Develop vendor/customer orientation 


Conduct vendor/customer orientation


Maintain list of PCTs on web


Monitor vendor service level
For example, verifying that catalogs/price lists are sent by vendor to appropriate agencies.

Activity
Description/Related DOA Forms

Contract Administration (cont)


Resolve complaints
Can involve meetings, follow-up phone calls, and/or written correespondence

Edit contract
DOA-41

Request/Review vendor reports


Conduct agency/vendor surveys


Renew if appropriate
DOP Renewal form

Bid List- Vendor Additions


Assess vendor Internet capabilities


Direct vendor to DOP Webpage
Also provide KAPS technical staff info/ contact point(s).

Verify vendor's federal ID#


Enter information into STARS
Form: Vendor Maintenance File Update

Inventory Additions (Non-Fixed Asset)


Review minor object code expenses
Process of determining applicable inventory items.

Compile STARS inventory info
In-depth process (using payment document/invoice) to find detailed info: Date of Purchase, Tag#, Reporting Level, Commodity Code, Vendor#,etc.

Enter data
Entering of above info into STARS non-Fixed Asset Table.

Inventory (non-fixed asset) 


Maintain office inventory records 
(e.g., office furniture, personal computers, etc.)

Work with inventory officer during physical counts


Perform physical counts


Develop and maintain agency inventory tracking systems 
(mainframe, PC based and manual records)

Record purchases, issues, transfers and adjustments


Develop costing methodologies


Calculate cost of goods sold (proprietary funds)


Coordinate reporting of inventory balances 
as needed for financial reporting requirements 

Change Order
DOA-41

Review renewal documentation
Can be vendor request and/or agency request. Contract Renewal form.

Request additional info/justification


Post change order in KAPS
Can be done centrally by buyer/technician, or entered and forwarded by agency.

Activity
Description/Related DOA Forms

Change Order (cont)


Buyer Authorization
Process: buyer signs hardcopy and authorizes electronically in KAPS mailbox

Supervisor Authorization
Supervisor reviews, then signs hardcopy

Forward advices to STARS
KAPS staff: activities of changing encumbrances, obligations, account codes, and unit prices

Copy/Distribute all advices
Usually done by technician.

Mail change order
File Room Clerk.

Forms Requisition
DOA-22 (Forms Requisition), DOA-8 (Quick Copy Center Transmittal), DOA-9 (Order for Printing). Note: Some forms are candidates for statewide forms website.

Fill out forms requisition
Includes establishing accounting info, order date, delivery date required, etc.

Fax/Mail to Finance Printing


Print form
Can either be at the Docutech in some major office buildings or for UPS or Printing to deliver. 

Order from Catalog
Core items are all in KAPS

Complete order form


Fax or Call order to vendor


Verify order receipt
Form: "Confirmation of Phone Order"

Enter receiving data
Also check delivery to bill of landing

Match invoice w/order/receipt


Procard Payment Processing


Download daily files
The daily responsibility of the ProCard Administrator using Hyperterminal, ProComm, etc.

Import files to PVS database
This activity also includes time spent contacting the ProCard PVS help desk if the Exceptions Log shows warn level 1 or 2.

Reconcile receipts to actuals


Resolve disputed transactions 
In an instance in which the merchant and ProCard Administrator cannot resolve simply, the bank is contacted and a dispute form filed.

Create Settlement report
This step derives the total dollar amount to be transferred to STARS

Map pay cycle transactions
Using the Mapper screen.

Transfer mapped file to STARS
Using WS FTP or TSO-based file transfer software.

Complete Dataset Input Request form
 This activity includes both completing the STARS-based form and faxing it to the Division of Accounts.

Activity
Description/Related DOA Forms

Procard Payment Processing (cont)


Identify/Correct Errors
Includes, when critical errors are involved, contact with agency Fiscal Officer

Print/Release pay document
DOA-65 (Procurement Card pay doc.)                 DOA-30 (Multiple Cost Dist. Form)

Process/Mail original doc.
Stamping, signing, and mailing to Finance/Accounts

Set-up Procard Administrator Site


Conduct agency overview
Basic overview of Procard process and associated benefits

Complete/Mail First Chicago forms
This includes the signing and mailing of:          Purchasing Card Company Record Form          Reporting Hierarchy Worksheet                           Authorized Signer(s) Form                                     Cardholder Application Form   

Complete Office of Controller forms
Agency Agreement Form                              Cardholder Agreement form

Evaluate hardware/technical reqmts.
Procard Technical Info Form- typically filed by the agency's IT unit

Acquire needed hardware/software
DIS Form F180

File STARS access request
DOA-64

Conduct cardholder training
Usually conducted by Agency Program Administrator.

Install software


Train administrator and backup


Complete Help Desk survey
Completing the "Procurement Card Follow Up Questions" survey.

Trade-In Surplus Item
B217-2 Declared Surplus Form,  vendor quote/allowance for trade-in, correspondence, internal cabinet transfer documents

Identify trade-in opportunity


Coordinate surplus property removal
In conjunction with the Purchasing Officer and the vendor

Update inventory & file records


Intra-Cabinet Surplus Transfer
Inter-office forms/paperwork.

Identify potential users


Coordinate surplus property move


Trash Surplus Item
B217-2, and hazardous waste handling documentation, if necessary

Contact Hazardous Waste branch
Necessary with lead acid batteries, used tires, EPA regulated chemicals, etc.

Update records


Activity
Description/Related DOA Forms

Transfer Item to New Agency
B217-2, B217-3

Negotiate transfer terms
These include price, date of transfer, delivery nuances, etc.

Conduct actual transfer


Update records


Transfer Item to Local Gvmt.
B217-2, B217-42A Direct Transfer, Pay-In-Voucher and Closeout forms

Negotiate transfer terms


Conduct actual transfer


Update records


Transfer Item to Non-profit Org.
IRS 501 c3 form, Donee card, B217-2, B217-42A Direct Transfer, Pay-In-Voucher and Closeout forms

Determine eligibility


Negotiate transfer terms


Conduct actual transfer


Update records


Sealed Bid
B217-2 Declared Surplus Form, Surplus Property Bid Form, Revenue Cabinet Form 51A102, Sales Use Tax Return and Revenue Journal Voucher Form 21A502, Journal Voucher DOA-1, and Pay-In-Voucher Form

Determine items to be sold


Create/Coordinate advertising


Mail bid forms/materials


Receive bid forms/deposits
This activity includes all planning and processing associated with tracking and holding all deposits safely.

Select winning bid(s)


Return deposits to losing bidders


Report sales tax to Revenue Cabinet
Several forms.

Complete B-217-2
If delegated authority, send to authorized agent within the cabinet.  If agency does not have delegated authority, route to Finance for approval.

Update internal inventory records


Public Auction
B217-2 Declared Surplus Form, Terms & Conditions of Sale, auction tickets, register receipts, Sales Tax Journal Voucher Form 21A502, Pay-In-Voucher Form

Identify items for sale


Negotiate contract w/auctioneer


Create/Coordinate advertising


Activity
Description/Related DOA Forms

Public Auction (cont)


Mark sale items or lots


Register bidders


Conduct auction


Document proceeds/sales taxes


Prepare Pay-In-Voucher
To deposit monies in State Treasury.

Prepare post-audit records


Complete B-217-2
If delegated authority, send to authorized agent within the cabinet.  If agency does not have delegated authority, route to Finance for approval.

Update internal inventory records


Requisition a Surplus Item


Agency identifies need


Purchase item with donee card
Activity carried out at Surplus Property branch.

Tag item if necessary


Enter invoice info
Usually entered by an accountant into Peachtree Accounting software.

Mail monthly statements
For all outstanding invoices.

Update internal and external inventory records


Cyclical or Support Activities

Cyclical activities are those activities that occur only during certain periods of the year or at a set frequency throughout each year.  Examples of cyclical activities include budget preparation, CAFR and year-end closing of accounts.  Support activities are those activities that are related to providing systems and computer support to an agency.  Examples of support activities include network operations and computer hardware/software maintenance.

The following specific activities have been provided to help you classify employees who are performing administrative services in your agency.  Where applicable, we have provided descriptions and indicated the Division of Accounting (DOA) forms that are associated with each activity.

These activities coincide with those listed at the top of the Activities Worksheets in Dept_Data.xls.  Blank columns have been included so that you may indicate activities that are performed in your agency but do not appear on this list.

Activity
Description/Related DOA Forms

Biennial Budget Request Preparation


Prepare new template
Based on changes dictated by new budget instructions. This includes revision of both macros and workbooks.

Develop training and materials


Compile agency history data
Some are also categorized by dept and division #

Check history data to CAFR


Data collection and assimilation


Prepare salary/benefit budget request


Prepare programmatic budget request


Prepare justification detail
Includes necessary supporting documentation

Respond to budget request inquiries 


Attend justification meetings


Annual Budget Request
Planning (DOA-49, 49A).

Determine mgmt budget amount
Activity of comparing enacted budgets to original budget requests.

Re-key budgets to desired levels
Completed in revised templates

Upload to STARS
Note: Some agenies type on DOA forms to be rekeyed into STARS.

Allocate enacted appropriations
To allotment, quarterly, major object and management budget levels as appropriate within the fund/agency 

Prepare allotment forms
Allotment and Appropriations (DOA-3, 4).

Activity
Description/Related DOA Forms

Annual Budget Request (cont)


Prepare appropriations/capital project requests


Annual Financial Reporting
Closing package to support CAFR (Comprehensive Annual Financial Reporting); other year-end activities.

Report capitalized leases


Identify accruals


Perform physical inventory


Research inventory discrepancies


Fixed Asset reporting/reconciliation
Conduct in conjunction with Finance Cabinet

Develop audit confirmation reports
Activities related to providing supporting info to gvmt bodies that require private annual audits (universities, horse parks, lottery,etc.)

Develop notes to fincl. statements


Compile fincl. Statements (GASB)


Compile fincl. Statements (for mgmt.)
Any supplementary reports (ie. cash basis) created independent of GAAP stipulations

Analyze actuarial liability projections


Year End Close


Close out system


Create new accounting codes


Roll over lasting encumberances


Establish new accounts chart


Prepare revised instructions


Support and Maintenance Activities


Security maintenance


Interface maintenance


System reconciliation


Data table maintenance


Report maintenance


Maintenance staff administrative functions


Appendix B: Communications Toolkit

As you are aware, most employees from managers to subordinates are anxious about how the MARS implementation will affect them, their jobs and their colleagues.  Throughout the organization assessment and design process, please be sensitive to the concerns of your colleagues and leaders by keeping them informed about the importance, timing and ramifications of MARS implementation.  This toolkit will provide you with the information and techniques you will need for communicating with your colleagues and navigating meetings with your agency leaders and data resources.

This appendix begins with a discussion of sensitivity issues and how to keep your colleagues fully informed about the organization design process and its implications regarding their positions.  The next section of this appendix provides general talking points to assist you in all of your meetings with agency leaders and data resources.  The remaining sections provide specific talking points for these audiences.

Sensitivity Issues

Most of the individuals you will approach during the data collection process will be concerned about providing you with confidential information about themselves or fellow employees, especially since the complete impact of MARS has not yet been determined.  For this reason, you should use discretion in circulating the materials you collect and discussing their contents.  Confidentiality is critical!  The Guidebook, templates, and worksheets should only be circulated among attendees of Course 1, agency leaders, and key data resources.

You should take time during your meetings with cabinet leaders and data resources to communicate thoroughly your understanding of the organization design process and answer any questions they have about the importance and ramifications of MARS implementation.  It is true that some positions may change or be deleted during the design process.  However, the EMPOWER Kentucky Administrative Services Team is committed to retraining and re-deploying, as necessary, all employees whose jobs are affected.  Please reassure your colleagues of this fact and point them to the EMPOWER Kentucky web site under change leadership (http://adm.state.ky.us) for more information.

Talking Points: All Meetings

During all meetings, begin with an introduction to the data collection process.  Use the following dialogue and the Introduction section of this Guidebook as guides to this communication.

We are conducting a baseline organizational assessment to understand the impact of the new MARS system on administrative services functions.  This data will provide critical information that will help your agency:

· identify the scope and timing of MARS and related training,

· ensure appropriate coverage for future to-be activities,

· identify opportunities for efficiencies, and

· identify anticipated workstation and MARS usage requirements.

Not participating in this activity may result in inadequate preparation for the July 1, 1999 rollout of MARS.  This information is critical because it will ensure that all employees:

· receive necessary training,

· are well informed about MARS implementation,

· understand their new roles and responsibilities, and

· are prepared to implement MARS and any new processes.

The deadline to complete the first stage of this assessment is October 15, 1998.

Talking Points: Meetings with Agency Leaders

The key messages to get across during your meetings with agency leaders are:

· Your cooperation is essential in completing this assessment in an accurate and timely manner.

· To facilitate the data collection, we seek access to selected personnel officers, agency heads, and division managers within the Cabinet.  In order to prepare those individuals for the data collection process, the Central Administrative Services Team has recommended that you send a standard memo (see Step 3: Inform Data Resources and A. S. Employees) to these key resources.  This memo explains the importance of data collection to MARS implementation and explains the key deadlines for data submission.

· The Central A. S. Team also recommends that you send a memo (see Step 3: Inform Data Resources and A. S. Employees) to all A. S. employees.  This memo should inform them of the data collection process, where it fits into MARS implementation and organization design plans, and how to reach the Administrative Services Project Web site.

Talking Points: Meetings with Data Resources

Key Messages

· Clearly communicate that activities related to administrative services are being included in the assessment.

· Emphasize that the information being collected is based upon what is really done and not PDQ or organizational chart information or formal definitions of what is being done.

· Be aware of sensitivity issues.  See discussion above for more details.

· Cooperation is essential in completing this assessment in an accurate and timely manner.

Process

You will probably need to meet with your data resources several times in order to complete all of the data collection templates.  It is suggested that you review Steps 4 through 8 prior to any meetings with Data Resources.  This will ensure that you are prepared in your first meeting to give them an overview of the time and effort that will be required over the next two months to help you complete all of the data collection templates.

1st Meeting

Your first meeting will probably occur during Step 4: Complete Org_Template.xls.  For this meeting, you should bring printed copies of Org_Template.xls, the Activities Dictionary and your Action Plan.  If you have a small or centralized agency, it may be appropriate to take all of the templates to your Personnel Administrator or other resource in the first meeting.

During the meeting, you should:

· Review the steps in your Action Plan that will require that individual’s assistance.  Explain the purpose of the assessment and the deadlines for completion of each template.

· Explain the formats and data requirements for the template(s) that you have brought for discussion. 

· Begin entering data, as appropriate.  It may be easiest to write the information on printed versions of the templates/worksheets during the course of this conversation.  However, some contacts may want to compile the data after some thought and discussions with key members of his/her staff.  

· Take time to answer any questions that arise.  If there are questions that you need assistance in answering, please contact Gail Prewitt (502-564-4240) immediately.

· Establish the time for a follow-up meeting as needed.  Suggest that the contact send you the completed template/worksheet so that you can examine and validate the data before the next meeting.

Between meetings

· Enter the data into the template/worksheets.

· Validate (i.e., double-check) the information.

· Highlight questions and/or incomplete data in preparation for the next meeting.

· Prepare for the next step in data collection.

Follow-up Meetings

· Complete entering the data.

· Confirm accuracy of the data and ensure that it is correctly entered in the template(s).

· Review the requirements for the next step in the data collection process, as needed.

Appendix C: Agency Administrative Services Index

The following table provides an index of administrative services for all agencies (i.e., cabinets and constitutional offices).  For each agency, the table indicates the names of the departments, divisions and branches in which administrative services are performed.  It also states whether each department is centralized.  Finally, it provides the number of Material Management and Financial Management FTEs that are budgeted for each organizational unit.

The data in this table was collected in November of 1997, so the data is fairly recent.  Please refer to this index to get an idea of which departments, divisions and branches include employees who perform administrative services functions.  This should be used as a guide only; please review all of the departments and organizational units in your agency to determine where administrative services activities are being performed.










Appendix D: Training Index

Below is a list of the courses that should be captured on the training worksheet

· Basic keyboarding

· Basic introduction to computers

· Windows 95 

· Microsoft Outlook (mail, calendar)

· Introduction to the Internet

· Advanced Internet

· MS Office 

· Word (beg., int., adv.)

· Excel (beg., int., adv.)

· Access (beg., int., adv.)

· Project (beg., int, adv.)

· CPA

· CPB

Appendix E: Software Assistance Guide

This appendix provides brief instructions for some of the Word and Excel features that you will need to use to complete the data collection templates.  It also provides troubleshooting tips for some common errors you may experience while operating these programs.  Finally, for those who are not familiar with Microsoft Word and Excel, there is a brief description of the common features you will need to use to open, close and save files.

This is not intended to be a comprehensive guide for these software packages.  If you need additional assistance, please refer to the manuals and tutorials that were provided by or press <F1> to access the on-line help menus.

What Software Versions Are We Using?

The data collection tools that have been provided on the Course 1 diskette include Microsoft Word and Microsoft Excel files.  These files are compatible with Microsoft Office 95 (Microsoft Word 5.0 and Microsoft Excel 5.0) or later.  If you cannot find or open the files, please contact Gail Prewitt (502-564-9596).

Tips for Problem-Free Data Collection
· Create second copies of all of the data collection tools before you start making any changes.

· Frequently save the file you are using.

· Allow time to enter data and check it – do not wait until the last minute!

Tips for Editing the Microsoft Excel Templates

Org_Template.xls

How do I enter information into a cell (block of the spreadsheet)?

To type date into a cell, you must first move to that cell.  You can use your arrow key to move to and highlight the cell you want to change, or you can use your mouse to move to the cell and click on your left mouse button to highlight the cell.

Once you have highlighted the cell, you can begin typing information.  To finish your entry and move on to the next cell, press the <Enter> key.

How do I change just a few of the words that I have entered in the cell without retyping all of the information?

Highlight the cell you want to change.  In the row just above the column labels (A, B, C, etc.) you will see an “=” sign and then a white box containing the data or phrase that is in the cell.  This is called the formula bar.  (Note:  If you do not see this bar, under the “View” menu, select <Formula Bar>.)  Use your mouse and left mouse button to click on the portion of that data/phrase that you want to change.  Then start typing.  Press <Enter> when you are finished making changes.

For example, if you have the phrase “The cow jumped over moon” and want to add a “the” before “moon,” you would highlight the cell.  In the formula bar, you would place your cursor before the “m” in moon and start typing.  When finished, you would press <Enter>.

How do I undo an action that I have just performed?

If you have made an entry or deletion that you did not want to do, you can undo the action.

1. Select the “Edit” menu at the upper left of your screen.

2. Select <Undo> from this menu. 

Alternatively, you can press these keys simultaneously: <Ctrl><Z>.

What do I do if I want to start over again with an empty template?

As suggested in the “Tips for Problem Free Data Collection” above, you probably created a second copy of all of the templates before you began entering data.  Just open that copy, save and rename it, then begin entering data again.

If you do not have a copy of the original, empty template and you need one, contact Gail Prewitt (gprewitt@mail.state.ky.us).

What if I have forgotten to include a Branch or Division level and want to insert it now?

You will need to insert a new row where you wish to add a new Branch or Division.  

1. Highlight the row that is currently located where you want to place the new entry.  (Note:  You can highlight a row by clicking on the number label that is located at the far left of the row.)  

2. Choose the “Insert” menu at the top of your screen.

3. Select <Rows>.  A new row should appear just above the row that you had highlighted.

What if I am collecting data for more than one agency/cabinet?

You should complete one “Org_Template.xls” file for each cabinet or constitutional office that you are representing.  To create a second file, open the original file that was provided on your Course 1 diskette and then save and rename it to reflect the name of the second agency (see Step 4: Complete the Org_Template).

How do I print the template?

1. Click on the “File” menu at the upper left of your screen.  

2. Select <Print> from this menu.  You should then see a smaller screen labeled “Print.”

3. Click on the <OK> button at the lower right of the screen.  This sends the file to the printer.

If the file prints in multiple pages but you want to see it printed on a single page:

1. Click on the “File” menu at the upper left of your screen.

2. Select <Page Setup>.  You should then see a smaller screen labeled “Page Setup” with four tabs at the top.

3. Click on the tab labeled “Page.”

4. In the center left of this screen, click on the circle next to the phrase “Fit to 1 page(s) wide by 1 tall.”

5. Press the <OK> button at the bottom right of the screen.

6. To print the file, follow the procedure given above.

Personnel Data Worksheet

What if I need to insert another employee (i.e., row)?

You will need to insert a new row where you wish to add the new employee or row.  

1. Highlight the row that is currently located where you want to place the new entry.  (Note:  You can highlight a row by clicking on the number label that is located at the far left of the row.)  

2. Choose the “Insert” menu at the top of your screen.

3. Select <Rows>.  A new row should appear just above the row that you had highlighted.

What if I want to delete an employee (i.e., row)?

1. Highlight the row that is currently located where you want to place the new entry.  (Note:  You can highlight a row by clicking on the number label that is located at the far left of the row.)  

2. Choose the “Edit” menu at the top of your screen.

3. Select <Delete>.  The row should disappear.

How do I copy and paste an existing employee row?

To copy a row or column:

1. Select the column or row you wish to copy by clicking on the letter label at the top of the column or the number label at the left of the row.

2. Select the “Edit” menu and choose <Copy>.  Alternatively, you can press these keys simultaneously:  <Ctrl><C>.

To paste a row or column:

1. Select the column or row you where you wish to paste the data by clicking on the letter label at the top of the column or the number label at the left of the row.

2. Select the “Edit” menu and choose <Paste>.  Alternatively, you can press these keys simultaneously:  <Ctrl><V>.

How do I copy and insert a row or column?

To copy a row or column:

1. Select the column or row you wish to copy by clicking on the letter label at the top of the column or the number label at the left of the row.

2. Select the “Edit” menu and choose <Copy>.  Alternatively, you can press these keys simultaneously:  <Ctrl><C>.

To insert the copied row or column:

1. Select the column or row you where you wish to insert the data by clicking on the letter label at the top of the column or the number label at the left of the row.

2. Select the “Insert” menu and choose <Copied Cells>.  

What if I cannot see all of the data in the column?

You need to widen the column.  To do this, locate the letter label at the top of the column you want to change (i.e., A, B, C, etc.).  Click on that letter to highlight the column.  Notice that your cursor appears as a large “+” sign.  Move the cursor slowly to the right until you see it change to a vertical line with arrows on either side.  Click twice quickly on your left mouse button.  The column should automatically fit the selection.

Alternatively, you can select the “Format” menu at the top of the screen and choose “Column.”  You should see another small menu pop up.  Choose <Auto Fit> from this menu.  The column should change to fit the selection.

How do I copy the first 3 columns so that I can paste them in the Activities Worksheet?

1. Select the first column or row you wish to copy by clicking on the letter label at the top of the column or the number label at the left of the row.

2. Pressing down and hold your left mouse button while you drag your mouse to highlight the remaining columns or rows.

3. Select the “Edit” menu and choose <Copy>.  Alternatively, you can press these keys simultaneously:  <Ctrl><C>.

How do I print the template?

1. Click on the “File” menu at the upper left of your screen.  

2. Select <Print> from this menu.  You should then see a smaller screen labeled “Print.”

3. Click on the <OK> button at the lower right of the screen.  This sends the file to the printer.

If the file prints in multiple pages but you want to see it printed on a single page:

1. Click on the “File” menu at the upper left of your screen.

2. Select <Page Setup>.  You should then see a smaller screen labeled “Page Setup” with four tabs at the top.

3. Click on the tab labeled “Page.”

4. In the center left of this screen, click on the circle next to the phrase “Fit to 1 page(s) wide by 1 tall.”

5. Press the <OK> button at the bottom right of the screen.

6. To print the file, follow the procedure given above.

Activities Worksheets

How do I paste the first 3 columns from the Personnel Data Worksheet?

1. Select the first column or row where you wish to paste the data by clicking on the letter label at the top of the column or the number label at the left of the row.

2. Pressing down and hold your left mouse button while you drag your mouse to highlight the remaining columns or rows (i.e., A, B and C).

3. Select the “Edit” menu and choose <Paste>.  Alternatively, you can press these keys simultaneously:  <Ctrl><V>.

How do I create a column for a new activity?

You will need to insert a new column to the left of the “Add Activity” column, which is located to the far right of the Activities Worksheets next to the “Subtotal FTEs” column.

1. Highlight the column that is currently located where you want to place the new entry.  (Note:  You can highlight a column by clicking on the letter label that is located at the top of the column.)  

2. Choose the “Insert” menu at the top of your screen.

3. Select <Columns>.  A new column should appear just to the left of the one that you had highlighted.

How do I delete a column that I have entered but don’t need now?

1. Highlight the column that you wish to delete.  (Note:  You can highlight a column by clicking on the letter label that is located at the top of the column.)

2. Choose the “Edit” menu at the top of your screen.

3. Select <Delete>.  The column should disappear.

What if I cannot see all of the data in the column, and get ### instead?

You need to widen the column.  To do this, locate the letter label at the top of the column you want to change (i.e., A, B, C, etc.).  Click on that letter to highlight the column.  Notice that your cursor appears as a large “+” sign.  Move the cursor slowly to the right until you see it change to a vertical line with arrows on either side.  Click twice quickly on your left mouse button.  The column should automatically fit the selection.

Alternatively, you can select the “Format” menu at the top of the screen and choose “Column.”  You should see another small menu pop up.  Choose <Auto Fit> from this menu.  The column should change to fit the selection.

How do I double-check the formula used in the Subtotal FTEs column?

The formula in the “Subtotal FTEs” column should sum all of the cells from column D to the column just before it.  In other words, if the “Subtotal FTEs” column is located in column AB, then the formula in the third row of this column (cell AB3) should show the following formula: SUM(D3:AA3).  Here, D3 and AA3 are called cell references and are formatted as [Column Letter][Row Number].  “D3:AA3” represent the range of cells to be added together, meaning that Excel will sum the cells as follows: D3 + E3 + F3 + …+ Z3 + AA3.

In order to check this formula, move to the cell located in the third row of the Subtotal FTEs column (from the example above, you would move to cell AB3).  The formula will appear in the formula bar, which is the white box that can be found above the column labels (i.e., A, B, C, etc.) and below the menus.  (Note:  If you do not see this bar, under the “View” menu, select <Formula Bar>.)

If the formula is not correct, edit it by typing in the formula bar.  Use your mouse and left mouse button to click on the portion of the formula that you want to change.  Then start typing.  Alternatively, you can insert cell references into the formula by highlighting the portion of the formula you wish to change and then clicking on the appropriate cell to add that cell’s reference.  Press <Enter> when you are finished making changes.

How do I copy the formula to the remaining cells in the column?

To copy one cell and paste it to multiple cells:

1. Highlight the cell you wish to copy.

2. Select the “Edit” menu at the upper left of the screen.  Select <Copy>.  (Alternatively, you can press <Ctrl><C>.)

3. Highlight all of the cells into which you want to paste, by positioning your mouse over the first cell, then pressing down and holding the left mouse button until you have highlighted all of the cells.  Alternatively, you can press these keys simultaneously to highlight cells:  <Shift><PageDown> or <Ctrl><Shift><DownArrow>.

4. Select the “Edit” menu at the upper left of the screen.

5. Select <Paste>.

What if I see an error in the “Subtotal FTEs” column?

You will need to check the formula that is currently entered in those cells.  Move to the first cell that contains the error (e.g., row 3).  Check the formula using the instructions above for “How do I double-check the formula used in the Subtotal FTE column?”

How do I print this huge template so that I can see all of the columns?

To print each worksheet, one at a time, you must first select the cells that you would like to print and then adjust the print settings as to the number of pages you wish to print.  Begin by adjusting the page setup:

1. Move to the worksheet that you wish to print (e.g., Financial Mgmt. Activities) using the tabs at the bottom of your screen.

2. Highlight the cells you wish to print.

3. Click on the “File” menu at the upper left of your screen.

4. Select <Print>.  You should then see a smaller screen labeled “Print.”

5. Near the bottom left corner of the screen, choose “Print Selection.”

6. At the bottom left of the screen, click on <Preview>.  You should then see an example of what the spreadsheet will look like.

7. Press the <PgDn> and <PgUp> keys to view the spreadsheet. 

8. If you wish to modify the page setting so that you shrink the view to fit on fewer pages or adjust the margins, click on the <Setup> button at the upper center of the screen.  Consult your Microsoft manual to guide you in making changes to the view.

9. When you are satisfied with the view of the spreadsheet, <Close> the preview screen.

To print the file:

1. Click on the “File” menu at the upper left of your screen.  

2. Select <Print> from this menu.  You should then see a smaller screen labeled “Print.”

3. If you want to print only the first few pages, locate the “Print Range” section at the middle left of your screen.  Type in the range of pages to print (e.g., 1 to 5).

4. Click on the <OK> button at the lower right of the screen.  This sends the file to the printer.

To show/hide all of the columns so that you can print them:

1. Click on the upper left corner of the spreadsheet to highlight all rows and columns.

2. Click on the “Data” menu at the upper center of your screen.  

3. Select <Group and Outline> from this menu.

4. Select Hide Detail or Show Detail.

5. Follow the printing instructions above.

Activities Summary Worksheet

What if I cannot see all of the data in the column, and get ### instead?

You need to widen the column.  To do this, locate the letter label at the top of the column you want to change (i.e., A, B, C, etc.).  Click on that letter to highlight the column.  Notice that your cursor appears as a large “+” sign.  Move the cursor slowly to the right until you see it change to a vertical line with arrows on either side.  Click twice quickly on your left mouse button.  The column should automatically fit the selection.

Alternatively, you can select the “Format” menu at the top of the screen and choose “Column.”  You should see another small menu pop up.  Choose <Auto Fit> from this menu.  The column should change to fit the selection.

How do I double-check the formula used in the Subtotal FTEs column?

The formula in the “Subtotal FTEs” columns of the Activities Summary worksheet should refer to the cells located in the corresponding row of the “Subtotal FTEs” column on the Activities worksheets.  For example, if the Subtotal FTEs column on the Financial Management Activities sheet is located in column AB, then cell D3 of the Activities Summary worksheet should contain the reference “='Financial Mgmt Activities'!AB3”.

In order to check this formula, move to the cell located in the third row of one of the Subtotal FTEs columns.  In the white formula box located directly above the column labels (i.e., A, B, C, etc.) you should see the formula that is currently entered in that cell.  Check that the formula is correct, as described above.  If it is not, you must correct it.

To correct it:

1. Highlight the cell you want to change (e.g., D3 of the “Financial Mgmt Subtotal FTEs” column).

2. Move to the white text box next to the “=” sign just above the letter labels of the columns.  

3. Use your mouse and left mouse button to highlight everything in the text box (the cell should become shaded black with the formula in white letters).

4. Move to the appropriate Activities worksheet (e.g., Financial Management Activities).  Notice that the text box at the top of the screen now says “=’Financial Management Activities’!”

5. Locate the “Subtotal FTEs” column.

6. Click on the cell in the row that corresponds to the row in which you are entering the formula on the Activities Summary.  For example, if you are entering a formula into D3 and the Financial Management Subtotal FTEs is in column AB, you would click on cell AB3.  Notice that the text box at the top of the screen will now say ““=’Financial Management Activities’!AB3.”

7. Press <Enter> to accept this formula.  You will be returned to the Activities summary so that you can check the remaining formulas.

How do I double-check the formula used in the Total FTEs column?

The formula in the “Total FTEs” column should sum the cells in the “Subtotal FTEs” columns, columns D through G.  For example, cell H3 of the “Total FTEs” column should show this formula: SUM(D3:G3).

In order to check this formula, move to the cell located in the third row of the Subtotal FTEs column.  In the white box located directly above the column labels (i.e., A, B, C, etc.) you should see the formula that is currently entered in that cell.  Check that the formula is correct, as described above.  If it is not, you must correct it.

Use your mouse and left mouse button to click on the portion of the formula that you want to change.  Then start typing.  Press <Enter> when you are finished making changes.

How do I copy the formula to the remaining cells in the column?

To copy one cell and paste it to multiple cells:

1. Highlight the cell you wish to copy.

2. Select the “Edit” menu at the upper left of the screen.

3. Select <Copy>.

4. Highlight all of the cells into which you want to paste, by positioning your mouse over the first cell, then pressing down and holding the left mouse button until you have highlighted all of the cells.  Alternatively, you can press these keys simultaneously to highlight cells:  <Shift><PageDown> or <Ctrl><Shift><DownArrow>.

5. Select the “Edit” menu at the upper left of the screen.

6. Select <Paste>.

What if I see an error in the “Subtotal FTEs” or “Total FTEs” column?

You will need to check the formula that is currently entered in those cells.  Move to the first cell that contains the error (e.g., row 3).  Check the formula using the instructions above for “How do I double-check the formula used in the Subtotal FTEs/Total FTEs column?”

How do I print this template?

To print the worksheet on a single page, you must first change the page setup:

1. Click on the “File” menu at the upper left of your screen.

2. Select <Page Setup>.  You should then see a smaller screen labeled “Page Setup” with four tabs at the top.

3. Click on the tab labeled “Page.”

4. In the center left of this screen, click on the circle next to the phrase “Fit to 1 page(s) wide by 1 tall.”

5. Press the <OK> button at the bottom right of the screen.

To print the file:

1. Click on the “File” menu at the upper left of your screen.  

2. Select <Print> from this menu.  You should then see a smaller screen labeled “Print.”

3. Click on the <OK> button at the lower right of the screen.  This sends the file to the printer.

Tips for Editing the Microsoft Word Templates

This section is intended to provide you with brief instructions on some of the Microsoft Word features you will need to use to complete the memos for Steps 2 and 3 and to complete the Position Description form in Step 8. 

For more detailed instructions, please refer to your Microsoft Word manual or access the on-line help function by pressing <F1> or using the <Help> menu at the upper right corner of your Microsoft Word screen.

How do I insert new words without typing over existing information?

1. Place your mouse over the place where you wish to begin typing and click your left mouse button to position your cursor there.  

2. Next, ensure that you are in <Insert> rather than <Type Over> mode.  Look at the bottom of your Microsoft Word screen.  You should see a row of information that begins with “Page.”  Near the center of this row, you should see a box with the letters “OVR” in it.  If this box is highlighted (i.e., letters are black), you are in <Type Over> mode.  Press the key on your keyboard labeled <Insert> or <Ins> to unhighlight the box.

3. Start typing.  If you find that you are typing over the existing words, press the <Insert> or <Ins> key again.

How do I type over existing words:

1. Place your mouse over the place where you wish to begin typing and click your left mouse button to position your cursor there.  

2. Next, ensure that you are in <Type Over> rather than <Insert> mode.  Look at the bottom of your Microsoft Word screen.  You should see a row of information that begins with “Page.”  Near the center of this row, you should see a box with the letters “OVR” in it.  If this box is not highlighted (i.e., letters are gray), you are in <Insert> mode.  Press the key on your keyboard labeled <Insert> or <Ins> to highlight the box.

3. Start typing.  If you find that you are not typing over the existing words, press the <Insert> or <Ins> key again.

How do I remove or delete words that I don’t want?

1. Place your mouse at the beginning of the word(s) you wish to delete. 

2. Press down and hold your left mouse button, and drag your mouse until you have highlighted the information you wish to delete.

3. Release the mouse button.  The information should still be highlighted.

4. Press the key on your keyboard labeled <Del> or <Delete>.  The information should disappear from the screen.

How do I copy information that I would like to insert somewhere else?

1. Place your mouse at the beginning of the word(s) you wish to copy. 

2. Press down and hold your left mouse button, and drag your mouse until you have highlighted the information you wish to copy.

3. Release the mouse button.  The information should still be highlighted.

4. Select the <Edit> menu at the upper left of your screen.

5. Select <Copy> from this menu.  

Alternatively, you can press these keys simultaneously: <Ctrl><C>.

How do I cut information that I would like to move somewhere else?

1. Place your mouse at the beginning of the word(s) you wish to cut. 

2. Press down and hold your left mouse button, and drag your mouse until you have highlighted the information you wish to cut.

3. Release the mouse button.  The information should still be highlighted.

4. Select the <Edit> menu at the upper left of your screen.

5. Select <Cut> from this menu.  The information should disappear from the screen.

Alternatively, you can press these keys simultaneously: <Ctrl><X>.

How do I paste information that I have cut or copied?

1. Place your mouse where you want the information to be inserted. 

2. Click your left mouse button to position the cursor.

3. Select the <Edit> menu at the upper left of your screen.

4. Select <Paste> from this menu.  The information should appear where you placed the cursor.

Alternatively, you can press these keys simultaneously: <Ctrl><V>.

General Troubleshooting Tips for Microsoft Word and Excel

Please refer to this brief guide if you experience errors while modifying a file, opening a file or saving a file.  If this does not provide you with a solution, press <F1> to access Microsoft’s on-line help functions or refer to your Microsoft manuals for troubleshooting tips.

I have Deleted or Pasted something I shouldn’t have!  How do I undo it?

If you have just deleted or pasted information, or have performed another action that you did not mean to do – do not fear!  So long as you have not saved or closed the file, you should be able to undo the last several actions you have performed.  

1. Select the “Edit” menu at the upper left of your screen.

2. Select <Undo> from this menu. 

Alternatively, you can press these keys simultaneously: <Ctrl><Z>.

The program has stopped working or has given me a fatal error!

Depending on the speed of your computer, the number of files or programs you have open, or a variety of other circumstances, these programs may give you a fatal error or stop responding on occasion.  If this happens, you must close the program.  If you receive an error box that gives you a <Close> button, click this button to close the program.  

If the program has frozen and just won’t work, press these keys simultaneously:  <Ctrl><Alt><Del>.  You should then see a small screen labeled “Close Program.”  It lists all of the programs that are currently open on your computer.  Click on Microsoft Word or Excel to highlight it, then press the <End Task> button at the bottom left of the screen to close the program.

If the program still will not close, you should probably reboot your computer.  Close any other programs that are still responding.  Then simultaneously press <Ctrl><Alt><Del>.  Select <Shut Down> at the bottom center of the “Close Program” screen.  Reboot your computer.

I received an error when saving/closing a file!

Errors while closing or saving files can usually be traced to one of two problems.

1. One common error while saving a file is “Disk is full.”  If you are trying to save to a floppy disk, this error means that the disk you are saving to is, in fact, too full, or you are trying to save a file that is too large to fit on the disk (e.g., is greater than 1.3 MB).  You must save the file to your hard drive and then try to copy the file to another disk or storage device.

If you are trying to save the file to your hard drive and receive this error, your hard drive is too full to store the file.  You should delete any unneeded files from your hard drive and then try to save the file again.  Good candidates for deletion are any files located in your c:\temp or c:\Windows\temp directories.  Particularly, any files ending in *.tmp can be deleted.  Refer to your Microsoft Windows manual for further instructions on deleting files from your hard drive.

2. Another common error while saving a file is “Cannot find file.”  This error occurs when you open a file on one floppy disk, then, without closing the file, you remove that floppy disk and put in a new one.  Windows 95 and later versions do not allow you to do this!  You have to first save the file to your hard drive, then swap floppy disks and save the file again to the new disk.

If error occurs, try putting the original floppy disk back in and then saving the file to the hard drive.  If this does not work or the program stops responding, refer to the directions above for receiving a fatal error.


Getting Started in Microsoft Word and Excel

This section is provided for those individuals who are beginners in using Microsoft Word or Excel.  It includes brief instructions on how to open, close and save files.  It also  and are not sure how to access files in these programs.  It provides brief instructions on some of the features that are common to both Microsoft Word and Excel.  These features are summarized in the following table.

· Open a file.
· Close a file.

· Save a file.
· Save and rename a file.

· Undo an action.
· Navigate in a file.

For more detailed instructions, please refer to your Microsoft manuals or access the on-line help function within a program by pressing <F1> or using the <Help> menu at the upper right corner of your program screen.

Open a File

To open a file, such as “Memo to Leadership.doc” on the Course 1 diskette:

3. Insert the diskette into your 3 ½” floppy drive.

4. Start Microsoft Word or Excel.

5. Click on the <File> menu at the upper left of your screen.  

6. Select <Open> from this menu.  You should see a smaller screen that says “Open” at the upper left.

7. In the list box beside “Look in:” at the upper left of the “Open” screen, click on the arrow and use the vertical sliding bar to locate your 3 ½” floppy drive (usually drive a:\ or b:\).  Click on that drive.  You should now see a listing of the folders/directories located on the Course 1 diskette.  These include Tools, Examples and Exercises.

8. Click on the folder labeled “Tools” until you see a listing of files contained in this directory (e.g., Action Plan.xls, Guidebook.doc).

9. Double-click on the file labeled “Memo to Leadership.doc.”  The file should now open on your screen.

Print a File

1. Click on the <File> menu at the upper left of your Excel screen.  

2. Select <Print> from this menu.

3. You will then see a smaller screen labeled “Print.”

4. Click on the <OK> button at the lower right of the screen.  This sends the document to the printer.

There are two alternatives to reaching the “Print” screen.  You can press <CTRL><P> simultaneously.  You can also click on the small picture of a printer located at the upper left of your Microsoft Word screen.

For additional printing features, consult your software manual or press <F1> to access the on-line help menu.

Save a File

To save a file without renaming it:

1. Click on the <File> menu at the upper left of your screen.  

2. Select <Save> from this menu.

There are two alternatives.  You can click use your mouse and left mouse button to click on the picture of a diskette located at the upper right of your screen.  You could also simultaneously press <Ctrl><S>.

Save a File and Rename It

It is recommended that, before making changes to a file, you save it using a different name such as “Memo to Leaders – my version.doc.”  This way, if you make any changes that you did not want, you will have the original file and can start over.

To save a file and rename it:

1. Click on the <File> menu at the upper left of your screen.  

2. Select <Save As> from this menu.  You should see a smaller screen that says “Save As” at the upper left.

3. In the list box beside “Look in:” at the upper left of the “Save As” screen, click on the arrow and use the vertical sliding bar to locate the drive where you wish to save the file.  Click on that drive.  You should now see a listing of the folders/directories located there. 

4. Locate and click on the folder in which you wish to save the file.

5. Click on the box next to “File name” at the lower left of the screen.

6. Type in the filename you wish to use.  You do not have to type “.doc” extension to indicate that this is a document.  The extension is automatically added to the name for you.

7. Click on the <Save> button at the upper right of the screen.

Note:  If you open a file on the Course 1 diskette and wish to save it to another floppy disk, you must first save the file to your hard drive (usually c:\).  Then, put in the new diskette and save the file to that disk.  In other words, you cannot open a file on one diskette, then remove that diskette and put in another one.  This will cause Word to crash (i.e., stop working) and you will lose any changes that you have made.

Close a File

1. Click on the <File> menu at the upper left of your screen.  

2. Select <Close> from this menu.

If you have made changes to the file but have not yet saved it, you will be asked whether you wish to save it at this time.

Navigating within a File

To navigate within the file, use your mouse and left mouse button, or use the arrow keys.  You can also use the “sliding bar” that should be located at the right of your screen.  To move up and down in the document, place your mouse over the horizontal bar, press down and hold the left mouse button, then slide the bar up or down.  When you have found the location you want, release the mouse button and click on the location in the document where you wish to type.

To navigate within the PD Form.doc, you may wish to use the <Tab> key instead of the mouse.  This will move you from field to field so that you can easily enter information.  To move to a previous field, press these keys simultaneously:  <Shift><Tab>.

Undo an Action

1. Select the <Edit> menu at the upper left of your screen.

2. Select <Undo> from this menu. 

Alternatively, you can press these keys simultaneously:  <Ctrl><Z>.
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To:	John Doe


Agency Head





From:	John Smith and Jane Jones


	MARS Agency Implementation Leads





Date:	� DATE \@ "MMMM d, yyyy" \* MERGEFORMAT �August 24, 1998�





Subject:	Important Data Collection Needs





As the designated MARS Agency Implementation Lead, I am responsible for coordinating critical events related to the Simplified Administrative Services MARS system implementation.   The Implementation Team’s next task is to gather baseline information about our current organizational structure, administrative services functions and employee position descriptions.  This information is due to the EMPOWER Kentucky Administrative Services Team no later than October 15.  In order to gather this information, I will require time and assistance from Personnel Administrators, departmental heads and other resources.  





At your earliest convenience, I would like to meet with you to discuss the best approach for collecting this data.  Following that, I would appreciate if you would send a memo to those individuals whom I will be contacting to supply data and a memo to all Administrative Services employees to inform them of the data collection process.





Attached is a table listing the primary steps of the data collection procedure, primary deliverables due to the EMPOWER Kentucky Administrative Services Team, examples of the resources that will be needed to supply the data, and the key deadlines for each deliverable.  Please contact me as soon as possible at (502)-564-…. with a convenient time that I can meet with you.








SAMPLE:


Memo to Leadership.doc





MEMO





SAMPLE:


Memo to AS Employees.doc








To:	Administrative Services Employees





From:	John Doe


		Agency Head





Date:	� DATE  \* MERGEFORMAT �08/24/98�





Subject: Data Collection





Over the past two years, most of you have become involved in, or at least aware of EMPOWER Kentucky changes in the area of administrative support.  These include use of the Procurement Card, statewide purchasing contracts, and reduced dependency on stockpiled goods.  You are also probably aware that preparations are under way to begin implementing the new Management Administrative and Reporting System (MARS).  This will affect how the state does financial reports and materials management.  It will replace a number of existing systems including STARS and KAPS.





During the next few weeks, we will be collecting information about how our administrative services are currently performed.  We will be collecting information about each employee who is involved in financial, procurement, or budgeting processes.  This will help determine whether or not the new processes and technology will affect our organization and how our work will change.  The data collected will help us do the following:





(	Anticipate computer work station needs.


(	Identify training needs for employees.


(	Identify ways to work more efficiently.


(	Be sure all activities are considered.


(	Coordinate the timing of MARS statewide implementation.





This data collection process does not necessarily mean that your job will change.  We simply do not know yet.  Once we have more detail about MARS, we will be able to better assess the impact on this agency and our work.  The MARS implementation team and I will keep you fully informed at every step along the way.  The (name of organization here) MARS team includes:


List MARS implementation team here


The Administrative Services Project has established a web site that includes information about both MARS and the Business Improvement Project (BIPS) activities.  You may wish to consult this site at � HYPERLINK http://adm.state.ky.us ��http://adm.state.ky.us� to stay on top of what is happening.





I am well aware of the importance of your work to this agency’s effective operation.  I value your contributions, past and present, and assure that we will manage this implementation in the best interests of our employees and our customers.  Please know that in the event your job does change, we will provide the training, tools and support for a smooth transition.  If you have any questions, please contact (MARS Agency Implementation Lead name here) at (phone/e-mail here).
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Please complete this worksheet only if you are contacted by the EMPOWER Kentucky Central Administrative Services Team!  They will contact you by September 30.
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To:	Data Resources





From:	John Doe


	Agency Head





Date:	� DATE  \* MERGEFORMAT �08/24/98�





Subject:	Critical data/information needs.





As you may know, I have designated an Implementation Team to help prepare our agency for the implementation of the forthcoming Management Administrative and Reporting System (MARS).  This system is the statewide, integrated and computerized financial and materials management processing system that is due to be launched in July of 1999.  It is part of the Commonwealth’s EMPOWER Kentucky initiative to develop more efficient and outcome oriented processes in the material, financial and budget management areas of each agency.  To fully recognize the benefits of this project, our agency must assess our current organizational structure and administrative services functions to insure that they are compatible with MARS.  





The Implementation Team recently attended the first of a series of workshops to learn about the full range of organizational assessment and design activities that will be needed.  Through the workshop, they developed skills and tools with which to gather as-is information about our organizational structure, administrative services functions and employee position descriptions.  Now the Team must collect this information and deliver it to the EMPOWER Kentucky MARS Team by October 15. 





In order to complete this process, your time and assistance will be needed.  Team members will be contacting you over the next few weeks.  Please take the time to help them complete this assessment as quickly and thoroughly as possible.  I understand that you are currently burdened with other projects and deadlines, but your participation in this assessment is critical.  If you have time conflicts that cannot be resolved, please contact me directly so that we can make other arrangements to collect the data.  





I thank you in advance for taking the time to provide the required information.  Your assistance will allow our agency and our employees to be fully prepared for the implementation of MARS next year.  If you have any questions, please contact us at __________.








SAMPLE:


Memo to Data Resources.doc
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Please submit a current position description form for each administrative services employee to Gail Prewitt by November 30.   If a current form is not available, follow these instructions to create one.
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